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PREFACE 
This manual, which describes the use of the VisiPlot program, is divided 

into three parts. 

The first part is an introduction that describes the VisiPlot program and 
what it does. It provides the basic information you need to load the program 
and the use of the keyboard and cursor. 

The second part is a series of four lessons that describe the major 
functions of the program and lead you on a step-by-step tour through 
their use. 

The introduction and lessons should be used while sitting at your com­
puter. You should follow the directions exactly as they are given. This is 
the fastest way to learn how to use the various parts of the program. 

The third part is a reference guide. It provides the information you 
need when you know how to use the program but have not used a certain 
function in a while. This guide also provides the information you need to 
execute those functions that are not covered in the lessons. 
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VISIPLOT ™ ~t~~l INTRODUCTION 

INTRODUCTION 
The VisiPlot program turns your Apple II computer into a graph plotting 

system. With this program you can ·enter and save chart data, display 
charts on your screen, print them on your printer, and save a binary 
representation of the chart for use by another program. The VisiPlot 
program communicates with the VisiCalc program and all other Personal 
Software programs that support DIF files. The program generates the 
types of charts shown in the following photographs. 

Line Chart 

Bar Chart 
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Area Chart 

Pie Chart 
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Hi-Lo Chart 

Scatter Chart 
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Additionally, with the use of the VisiPlot overlay and window capabili­
ties, combinations of all the formats, except Pie, are possible. (A Pie chart 
is a unique form that is always handled separately.) 

Line and Bar Chart 

Comparative Bar Chart 
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The VisiPlot program offers more than just a full repertoire of chart 
forms. 

It can handle 16 data series in memory. A single chart can contain up to 
150 data points. A total of 645 data points can be handled in memory. 
The VisiPlot program analyzes the data in a selected series or multiple 
selected series and automatically determines the best X-axis and Y-axis 
value ranges for that chart. 

It automatically generates different plotting symbols for charts with 
multiple data series. It selects different colors the different series in mul­
tiple line, bar, and area charts. 

The VisiPlot titling features are extensive. A chart can have as many 
as five fixed title lines. Three at the bottom of the chart, one at the top, 
and one at the left. There is no limit to the number of moveable title lines 
you can put into a chart. A moveable title line can be placed anywhere in 
a chart. Most fixed titles can be displayed in a regular or bold typeface. 

The program can output finished charts to several graphic printers: the 
Apple Silentype, the IDS 440G and 445G Paper Tigers, the Trendcom 
200, and the NEC Spinwriter models 5510, 5515, 5520, and 5525. 
Appendix B of this manual list the features that must be installed in 
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each of these printers and the required settings of the switches on the 
printers. The VisiPlot program prints data listing to most printers that 
can be plugged into the Apple II or Apple II Plus. 

The VisiPlot program also provides the means of writing binary chart 
data to diskette for use by other programs, such as output drivers for other 
graphic printers or display programs to redisplay the charts on a monitor 
or TV. 

Color display capability is a standard part of the program. You can 
display your charts in blue, green, orange, violet, black, and white. You 
have control over the choice of background colors as well as plotting 
colors. The program provides standard color selections that display well 
together. On black and white display screens, blue, green, orange, and 
violet display as a shade of grey easily distinguished from black and 
white. 

Foremost among the VisiPlot features is the support of DIF (Data Inter­
change Format) files. Through the use of this data format, data from other 
sources, such as the VisiCalc program, can be loaded and plotted with the 
VisiPlot program. In a like manner, VisiPlot data can be saved as a DIF 
file and then loaded by those programs that support DIF files. 

USING THE VISIPLOT PROGRAM 

The VisiPlot program is easy to use. There is no detailed syntax to learn 
or look up, no special keyboards to memorize, and no abbreviations to 
confuse you. The VisiPlot programs are menu-driven. This means that 
they display a menu of the options from which you can choose. With the 
very simple technique of pointing to the option with a cursor and pressing 
a single key, you select an item from the menu. 

A cursor is a graphic device that appears on the screen. By pressing 
keys on the keyboard you can move the cursor to highlight an item in a 
menu. It is even easier than it sounds. The following picture is a typical 
VisiPlot menu; the LINE option is highlighted by the cursor. 
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The VisiPlot program draws the six different kinds of charts that were 
pictured earlier: 
• Line charts, which consist of points plotted against a value axis and a 

time axis. The points can be connected by a line or can be plotted 
without the connecting line. 

• Bar charts, which consist of vertical bars that show value by their 
height. 

• Area charts, which are line charts with the area between the plotting 
line and the base line filled in. 

• Pie charts, which show percentage of a whole or total with segments 
of a circle. 

• Hi-Lo charts, which show a range of values at a specific time with a 
vertical line . 

• Scatter charts, which show two sets of values plotted against each other. 

The VisiPlot software contains two programs, one that handles storage 
management and data editing and one that does the plotting. The com­
bined programs are too large to fit into the computer memory along with 
plotting data. You can freely switch between the programs. Plotting data 
that you have in memory is safely kept in memory when you change 
programs. 

The storage management program loads data from diskette, saves data 
on diskette, lists the data currently in memory, controls the assignment 
of disk drives, clears unwanted data from memory, and provides the 
means of entering new data and modifying the existing data. 
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The storage management section also provides the means of loading 
the plotting program. When you initially load the VisiPlot program, oper­
ation begins in the storage management section; you have to load data 
from diskette or create new data before drawing charts . 

. SOME DEFINITIONS 

This manual uses some terms that might be new to you or that you use 
in a different way. It is important that you and the book always mean the 
same thing; it will save you time and frustration. 

CHART 

The output of the plotting program. The graphic representation of one 
or more data series. 

COMMAND 

An order given to the computer program. In the VisiPlot program, 
commands are issued by selecting a menu item. 

CURSOR 

An area on the screen used to point to items in menus and lists. The 
cursor is controlled with the right and left arrow keys and the space bar 
in menus and by the right and left arrow key in lists. The cursor is a 
white area on the screen. When the cursor is pointing to an item, the 
item is displayed in dark letters against the white background. 

DATA POINT 

A numeric value that is associated with a date. The value is plotted 
against the Y-axis and the date against the X-axis. Data points, along 
with their associated date, make up a series. 

DATE 

A value indicating a year or point within a year. A date is associated 
with every data point. 

FILE 

A collection of data on a floppy diskette. A file can contain from 1 to 
16 series. 
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The operation or processing the program does in response to a 
command. 

GRID 

Horizontal and vertical lines on a chart used as an aid in determining 
the value of a point or bars. In the VisiPlot charts, grid lines are series 
of small dots, light against a dark background and dark against a 
light background. 

LIST 

A display that offers a collection of data items, one or more of which 
are selected with the cursor, the space bar, and the RETURN key. 

MENU 

A display that offers two or more command choices. The choices in a 
menu are selected with the cursor and the RETURN key. 

PERIOD or PERIODICITY 

The frequency at which data points occur within a year. A period of 
one means the data is shown on a yearly basis. A period of 12 means 
the data is shown on a monthly basis. This manual uses the word period. 

POINT 

See Data point 

RANGE 

The period of time covered by a series or the scope of the series. 
The range is the beginning date (and period) to the ending date 
(and period). 

SCALE 

The scope of values covered by the Y-axis of a chart. A scale usually, 
hut not always, covers the highest and lowest values in a series. 
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A collection of data points. A series is the basic unit of data that the 
VisiPlot program uses in memory. A series has a name. On diskette, 
one or more series, to a maximum of 16, are stored in files. 

X-AXIS 

The horizontal axis of a chart. VisiPlot plots the date on the X-axis 
(except on scatter charts) . 

Y-AXIS 

The vertical axis of a chart. VisiPlot plots the data point values on 
the Y-axis. 

APPLE COMPUTER REQUIREMENTS 

To use the VisiPlot program your computer must have: 

• 48K or more of RAM memory. 
• A video monitor or a TV set. The video monitor is preferable. The 

display device can be color or black and white. The color capability 
is preferable; it lets you make full use of the VisiPlot color capabilities. 

• One or more Apple Disk II disk drives. The disk controller must have 
the I6-sector proms installed. (The I6-sector proms come with the 
Apple Language System and with the Apple DOS 3.3.) You should 
have at least one blank diskette to begin with. 

• The Apple Language System card or the Applesoft ROM. 
• The VisiPlot program diskette. This diskette is in the inside front cover 

pocket of the binder holding this manual. 

SETTING UP YOUR APPLE COMPUTER 

If you are using your Apple for the first time, be sure to follow the Apple 
instructions on how to set up the computer. 

The computer power cord should be plugged into the back of the Apple 
and into a wall socket. Likewise, the video monitor or television power 
cord should be plugged in. 

If you have a video monitor, the dealer should have supplied you with a 
cable to connect it to your Apple II. The monitor instruction manual or the 
dealer can supply the information on setting any switches on the unit. 
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Make sure the cable is plugged into the jack labeled VIDEO OUT on the 
back of your computer. The input to the monitor is probably labeled 
VIDEO INPUT or something similar. If you have difficulty identifying the 
input, see your dealer. 

If you use a television set, you need an RF Modulator and cable. 
This device changes the signal put out by the Apple so that it matches 
what the television expects. Ask your dealer for an RF Modulator, or 
see your Apple BASIC or APPLES OFT manual for information on where 
to obtain one. 

Your Disk II drive should be connected by a ribbon cable to the 
connector labeled Drive 1 on the Disk II controller card. If you have 
two disk drives, the second should be connected to the connector 
labeled Drive 2. The controller card should be plugged into the slot 
numbered 6 at the back of the Apple main circuit board inside the 
computer. This is a very sensitive step; ask your dealer to show you 
how to install the drive and controller card properly. 

If you have two or more controller cards, they must be plugged into 
consecutive slot numbers to be used with the VisiPlot program. The 
Drive I connected to the controller card in the highest slot number, 
must be used to load the program. 

Take time now to read Chapter 1, "Installation and Handling" of 
your Apple Disk Operating System Instructional and Reference 
Manual. 

IF YOU HAVE TROUBLE 

If you have any trouble at any point in the set up, see your Apple 
dealer. Don't try to load VisiPlot until the computer is set up and 
operational. 

THE VISIPLOT PROGRAM DISKETTE 

Your copy of the VisiPlot program comes on the diskette in the 
pocket of the VisiPlot binder. This diskette cannot be copied. See the 
"Warranty Policy for Productivity Series Software" card in the binder 
replacemen t information. 
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Y our diskettes are small plastic disks coated with magnetic material 
on which data can be stored. The diskettes are permanently sealed in 
a square cover for protection. The cover keeps it clean and yet, allows 
it to spin freely. This protective cover is never opened. 

N ever let anything touch the brown or gray surface of the diskette. 
Handle the diskette only by the plastic cover. When a diskette is not 
being used, keep it in the paper pocket in which it came. These pockets 
are treated to minimize static buildup which attracts dust. It is best to 
store your diskettes in a vertical position, in their box, a diskette 
holder, or notebook specially designed for them. 

Diskettes hold a large amount of information. The information is 
stored in bits which occupy a very small area of the diskette. An 
invisible scratch on the surface of the diskette, even a fingerprint, can 
destroy data. Do not put diskettes on dirty or greasy surfaces; do not 
let them collect dust. 

When writing on a diskette label, use a felt tip pen. Do not press hard. 
It is best not to write on a label attached to a diskette. Write on the label 
and then put it on the diskette. 

Keep your diskettes away from magnetic fields. This means keep them 
away from magnets, electric motors, and television sets. 

Diskettes are sensitive to temperature extremes. Keep them out of the 
sun and away from heat sources that can warp them and cause data loss. 
On hot days, car trunks and dashboards can destroy diskettes. Diskettes 
operate satisfactorily up to 52 degrees Celsius (approximately 125 degrees 
Fahrenheit). The first indication of heat damage is a warped or bent 
plastic cover. 

With reasonable care a diskette will give you an average life of 40 
hours, which is a long time when you consider the short time it takes to 
load most programs. But just a little bit of carelessness can destroy its 
usefulness. 
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A disk drive door is opened by pulling outward and upward on the 
bottom edge of the door. The diskette is slipped into the slot with the label 
facing upward as shown in the photograph. The edge of the diskette with 
the oval cutout should enter the drive first; the edge with the label should 
enter face up and last. 

001-001 

Push the diskette gently into the drive. Do not bend it. When it is totally 
in the drive, close the drive door by pushing it down. The two metal fingers 
that can be seen inside the slot as the door is closed should clear the 
diskette. 

To remove a diskette, open the door and pull the diskette straight out of 
the slot. Opening the drive door lifts the read/write head from the diskette 
surface. If you leave a diskette in a drive for long periods without use, it is 
a good idea to open the door so the read/write head does not rest on the 
diskette. 

Never remove a diskette while the IN USE light on the drive is lit. This 
can permanently damage the diskette and is almost certain to destroy 
the information on it. You may be able to reuse such a diskette but will not 
be able to recover the lost data. 
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The figure shows the Apple II keyboard. You will use all the keys with 
the VisiPlot program. There are certain keys that are used very often. 
They are pointed out in the figure. These keys, with the exception of the 
RESET key, are explained in the lessons. The RESET key is discussed in 
the following section. For now it is important that you know their names 
and locations on the keyboard. 

ESC RESET 

SPACEBAR LEFT ARROW 001-002 

The Reset Key 

NEVER PRESS THE RESET KEY. 

If you are a beginner to the VisiPlot program, some of the following 
may not be meaningful to you right now. Please read this section now 
even if it is not completely meanigful. Because of its location on the 
keyboard it is easy to press the RESET key accidentally. This section tells 
you what to do if the program is not able to recover. 

The RESET key is very different than the other keys on the keyboard. 
If you press it accidentally and you have an Autostart ROM installed in 
your computer, the VisiPlot program almost always recovers, by taking 
you to the main menu of the program you are currently using. Any action 
that was in progress, such as drawing a chart, is canceled. 

If you press RESET, while saving data to a diskette, you will very likely 
destroy the file. 
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If your computer does not have an Autostart ROM installed, pressing 
RESET will put you in the system monitor. The system monitor displays 
an asterisk (*) prompt. If this happens, do the following: 

1. Type 3DOG and press the RETURN key. 
2. If you are in the storage management program, type GOT a 1000 

and press the RETURN key. If you are in the plotting program, type 
GOTO 205 and press the RETURN key. The GOTO statement 
should be typed when the Applesoft prompt (]) is displayed. 

3. If this does not put you back into the correct VisiPlot program, you 
must reload the program. DO NOT TYPE RUN TO RECOVER 
WHEN YOU ARE IN BASIC. 

The CTRL-C Key 

The CTRL-C signal is generated by pressing and holding the CTRL 
key and then pressing the C key. The CTRL-C stops graphic or text 
printing operations. Do not press the CTRL-C while a disk drive is oper­
ating; it may cause an error that could destroy a file or all the data on the 
diskette. 

PRINTER SUPPORT 

As noted earlier I the VisiPlot program supports several different graphic 
printers. Appendix B contains a list of the supported printers with the 
required options and switch settings where applicable. It also contains 
a list of the graphic printers and interface cards that are not currently 
supported by the VisiPlot program. 

As you received the program diskette, it is configured to print on the 
Apple Silentype printer. If you use an Apple Silentype printer or do not 
have a printer connected to the computer, you do not have to make any 
changes and can skip the remainder of this section and go on to "Loading 
the VisiPlot Program~' 

Each printer requires a different driver program to correctly reproduce 
your charts. These driver programs are on your VisiPlot program diskette. 
The name of the driver programs that support each printer are listed in 
AppendixB. 

If you have a printer other than the Apple Silentype, you must change 
the name of two files on your program diskette. Before you can change 
anything on the diskette, you must remove the write-disable tab. The write­
disable tab is on the right upper side of the diskette as shown in the follow­
ing figure. 
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Leave Uncovered 
to Allow Disk Write Cover for Write Protection 

Label Jacket Oval Cutout 001-003 

Carefully remove this tab. Be very careful not to bend the diskette. If 
you do not have spare tabs, keep this one; it must be replaced later. Do 
the following after you remove the tab. 

1. Put your Apple DOS 3.,3 System Monitor diskette into the disk drive 
and turn the system on. 

2. Put your VisiPlot program diskette into the second disk drive. If you 
have only one disk drive, remove the DOS 3.3 System Master diskette 
and put the program diskette in that drive. The remaining steps 
assume you are using two disk drives. If you are using one drive, 
enter D I each time the example shows D2. 

3. Issue the following DOS 3.3 command: 
RENAME VISIPLOT .DRIVER, SILENTYPE.D, D2 

4. N ext rename the driver program for your printer, shown as xxxxx.x, 
to VISIPLOT.DRIVER: 
RENAME xxxxx.x, VISIPLOT.DRIVER, D2 

5. Remove the VisiPlot program diskette from the disk drive and replace 
the write-disable tab. 

LOADING THE VISIPLOT PROGRAM 

The procedure to load the VisiPlot program depends on the configura­
tion of your Apple II or Apple II PLUS. Use the procedure for your 
configuration. The 16-sector proms must be installed in the disk controller 
card. 

Procedure I must be used on Apple II PLUS computers with or without 
the Language System and on Apple II computers with the Applesoft 
ROM installed. These systems have Applesoft Basic in the system. 
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Procedure 2 must be used on Apple II computers with the Language 
System installed but without Applesoft in ROM. Applesoft Basic must first 
be loaded into these systems. 

Procedure 1 

1. With the computer power turned off, put the VisiPlot diskette in Drive 
1 and close the door. If you have a second drive, it should be empty at 
this time. If you have multiple disk controller cards, use the Drive 1 
that is connected to the controller card that is plugged into the 
highest numbered slot. This is usually slot number 6. 

2. The display unit (monitor or TV set) should already be turned on. 
Turn the computer power switch (located on the back left of the 
computer) on. The red IN USE light on the disk drive lights and the 
drive begins to run. In less than 1 minute you will see the VisiPlot 
startup display on the screen. 

Procedure 2 

1. With the computer power turned off, put the DOS 3.3 System Master 
diskette in Drive 1 and close the door. If you have a second drive, 
it should be empty at this time. If you have multiple disk controller 
cards, use the Drive 1 that is connected to the controller card that is 
plugged into the highest numbered slot. This is usually slot number 6. 

2. The display unit (monitor or TV set) should already be turned on. 
Turn the computer power switch (located on the back left of the 
computer) on. The red IN USE light on the disk drive lights and the 
drive begins to run. In a short time, Applesoft Basic will be loaded 
into the computer and the Integer Basic prompt (» is displayed. 

3. Open the drive door and remove the DOS 3.3 System Master diskette. 
4. Insert the VisiPlot program diskette and close the door. 
5. Type RUN INIT and press the RETURN key. The red IN USE light 

on the disk drive lights and the drive begins to run. In less than 1 
minute you will see the VisiPlot startup display on the screen. 
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The photo shows the intitial display after loading the VisiPlot program. 

The four lines at the top of the screen-one light, two dark, and one 
light-are called the status area. The status area gives you information 
about the computer and program and contains the menus of the com­
mands you can give to the VisiPlot program. 

The reverse video lines (the top and bottom lines) supply information 
or give direction. The normal video lines (the two middle lines) display a 
menu, messages from the program, or provide a space for data entry. 

Below the status area are two lines that contain the version number of 
the VisiPlot program that you loaded and the copyright notice. If you do 
not have the version number written down, do it now. You will need it in 
the event you ever have trouble with the program. The copyright notice 
shows that the program on this diskette is protected by the United States 
Copyright laws. Be sure to read the notice inside the front cover about 
the copyright protection of this program and manual. 

Under the copyright there are two lines of directions on how to select 
an item from the menu. 
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Look at the menu lines in the status area, notice that one item is shown 
in reverse video (black on white). If you just loaded the program and 
have not pressed any keys, that item is LOAD. 

Press the right arrow key on the keyboard. The reverse video area 
moves to the word - > PLOT. The reverse video area in the menu is 
called the cursor. Pressing the arrow key moves it in the direction indi­
cated. Press the left arrow key and the cursor moves back to LOAD. 

As you move the cursor the top line of the status area changes. With 
the cursor pointing to LOAD, the top line reads LOAD SERIES and with 
the cursor pointing to ->PLOT, it reads GO TO VISIPLOT. The informa­
tion in the top line is called the Long Prompt. It gives a longer description 
of the menu item to which the cursor is pointing. 

There are two menu lines. With the right arrow key, move the cursor to 
the right end of the top line, to <MORE>. Now press the right arrow key 
once more. The cursor jumps to the left end of the bottom line. This cursor 
action is called wraparound. 

Cursor wraparound works in both directions. Press the left arrow key 
and the cursor jumps back to the right end of the top line. From the right 
end of the second line it jumps to the left end of the top line. 

It is inconvenient to move the cursor across the whole menu line to reach 
the other line. With the cursor on LOAD, 'press the space bar. The cursor 
moves down, directly to the bottom line, to EDIT. Press the space bar again 
and the cursor moves back up to the top line. 

The use of the space bar and the arrow keys makes cursor movement 
very easy and convenient. 

SELECTING A MENU ITEM 

Moving the cursor to a menu item causes no action to take place. To 
select a menu item, you must move the cursor to the item and then press 
the RETURN key. 

Move the cursor to LOOKUP and press the RETURN key. The message 
NO ACTIVE SERIES appears in the status area, replacing the menu. As you 
pressed the RETURN key, there was a beep from the computer signalling 
that an abnormal situation occurred. In this case, you selected a function 
that displays a list of the plotting data currently in memory. The program 
could not do this because there is no plotting data in memory. 
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However, something more important than an error happened. You lost 
the menu and cannot do anything. The progam is menu-driven, which 
means all commands are issued by selection from a menu, You must have 
a menu on the screen if you are to do anything. When you reach this 
situation-no menu on the screen-press any key on the keyboard except 
the RESET key. Pressing keys such as SHIFT and CTRL have no effect 
because they are always used in conjunction with another key. But press­
ing any other key erases the message in the status area and redisplays 
the menu. 

It is important to remember: ANYTIME YOU SEEM TO BE AT A 
DEAD END WITH NO WAY TO CONTINUE, PRESS ANY KEY 
EXCEPT RESET, SHIFT, AND CTRL. 

MORE ABOUT THE STATUS AREA 

The bottom line of the status area lists a Slot and Drive number. This is 
the Slot and Drive address for the diskette that the program uses to load 
and save plotting data. If you have a single drive system, the line should 
indicate Slot 6 and Drive I. (Slot 6 is the normal slot used for a single 
disk controller.) If you have only one drive, it must be plugged into the 
Drive I connection on the controller board. 

If you have more than one drive, you can choose which drive is used 
for data. This is covered in Lesson Three. 

MORE ABOUT THE CURSOR 

With the arrow keys and/or space bar move the cursor to LOAD and 
press the RETURN key. The disk drive starts running and the message 
READING DIRECTORY ... appears in the status area. The drive stops and a 
list of names is displayed below the status area. This is a list of files on the 
VisiPlot program diskette containing data that can be plotted. These 
sample files are supplied as part of the lessons in this manual. The data 
in these files is fictional; it does not represent any actual condition or 
circumstance. 

All you are going to do with this list now is to learn how the cursor works 
in a list. 

The cursor has moved from the status area to the top item of the list. 
Press the right arrow key. The cursor moves to the next item down the 
list. Press the left arrow key and the cursor moves back up to the first item. 
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Press the right arrow key until the cursor reaches the bottom item which 
is (NONE). Now press the right arrow key once more. The cursor jumps 
back to the top of the list. Wraparound works on the list as well as the 
menu. Now press the left arrow key to see if the cursor wraparound also 
works from top to bottom. It does. 

This is a list you will use in Lesson One to load data from the diskette 
into the computer memory. For now we don't want any data. To select 
an item from the list, press the RETURN key with the cursor on the desired 
item. For now move the cursor to (NONE); and press the RETURN key. 
The list vanishes and the menu returns to the status area. 

SUMMARY 

Now you are ready to go on to the VisiPlot lessons. Lesson One is about 
drawing charts on the screen. Lesson Two covers the Storage Manage­
ment program except for the Edit functions. The Edit functions are 
covered in Lesson Three. In Lesson Four, you will return to plotting and 
learn to do some of the more complex charts. 
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LESSON ONE 

THE BASIC USE OF THE VISIPLOT PROGRAM 

If you have not read the Introduction, do so before continuing; it 
contains the basic information that this lesson assumes you already know. 
It tells you how to load the VisiPlot program, what the cursor is, how to 
move the cursor, and more. 

This lesson assumes you know: 
• How to load the VisiPlot program from diskette. 
• How to move the cursor in amen u and in a list. 
• How to select an item from a menu and a list. 

If you are not sure how to perform any of these functions, reread the 
sections of the Introduction that describe them. 

This lesson introduces some of the major functions you encounter using 
the VisiPlot program. This lesson deals almost totally with the Plot pro­
gram. You are given instructions on how to load some plotting data and 
how to set to the Plot program. There are no explanations of these direc­
tions in this lesson; they are explained in Lesson Two. 
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LOADING THE PROGRAM 

Load the VisiPlot program according to the directions in the section 
"Loading the VisiPlot Program~' For the purpose of this lesson, do not put 
a diskette in Drive 2 if you have a multiple drive system. Leave the Drive 2 
door open. 

When the program is loaded the display should look like the following 
photograph. If it does not look like this, go back to the Introduction and 
start over. 

If the bottom line of the status area reads DRIVE: 2 instead of DRIVE: 1, 
load the program again without a diskette in Drive 2. 

The Storage Management program is now loaded; this program is the 
subject of Lesson Two. For now we want to load some data that can be 
plotted, load the Plot program, and draw some charts on the screen. Press 
the following keys in the order listed: 

(make sure the cursor is on the word LOAD) 
1. RETURN (wait for the disk drive to stop running and make sure the 

cursor is on SAMPLE 1) 
2. RETURN (again wait for the drive to stop, a list of the data series in 

SAMPLE I is displayed) 
3. RETURN (the list disappears and the menu returns) 
4. Right Arrow (move the cursor to ->PLOT) 
5. RETURN 
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At this point, the message NPE V TO CONFIRM should be displayed in 
the status area. If this message is not displayed, move the cursor to the 
word LOAD and repeat the preceding sequence. If there is no menu, 
press any key except RESET. 

If you have the correct message, press the Y key on the keyboard. The 
VisiPlot program gives you this chance to verify that you want to change 
programs. Pressing any other key cancels the loading of the Plot program. 

If you accidentally pressed the wrong key, move the cursor to the word 
- > PLOT and press the RETURN key again. 

After you press the Y key, the disk drive runs for a short while. When it 
stops, the TYPE V message is replaced with ONE MOMENT PLEASE", At 
this point, the program is initializing itself. In a short time the disk drive 
begins again and the message GETTING PLOT PROGRAM", replaces the 
request to wait a moment. The disk drive stops and the screen goes blank 
for a moment. 

The line PLEASE CHOOSE GRAPH NPE appears near the bottom of the 
screen. A new status area appears under the line. You are now in the Plot 
program. The screen looks like the following photograph. 

In the Plot program, the status area is at the bottom of the screen. This 
allows a chart to be displayed along with the status area without destroy­
ing any of the chart. The status area covers up the bottom titles and the 
chart legend but you can turn the status area display on and off at will 
when a chart is displayed. More about this later. 
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THE SELECT MENU 

The menu in the status area is the Select menu. You use it to select the 
type of chart you want to draw and the series. The menu items indicate 
the six kinds of VisiPlot charts: LINE, BAR, AREA, PIE, HI-LO, and 
SCADER. The last item on the menu, NONE, provides a way to exit from 
this menu without choosing a chart type. This exit path comes in handy at 
times, especially after you get to this menu by mistake, which can happen 
w hen you become very familiar with the men us and start using them very 
fast. 

Move the cursor around within the menu. Read the long prompts in the 
top line of the status area. They explain each choice in a little greater 
detail. For example, when the cursor points to LINE, the long prompt says 
CONNECT POINTS IN A LINE. The long prompts are an aid if you forget 
what a menu item does. 

Move the cursor to LINE and press RETURN. You just elected to draw a 
line chart. 

The menu disappears and is replaced with <-, ->, SPACE OR 
RETURN. A list of names appear at the top of the screen. This is the same 
list you saw after loading SAMPLE 1. This is a list of the data series that 
are currently in memory. 

The list includes some information about each series. Going across the 
header line, the informational items are: 

NAME: This is the name of the data series. Series names should be 
descriptive; they should indicate what data they contain. 
The two series in this list contain some sales data and some 
history data. 

PER: This is the period of the series. Both series in the list have a 
period of 1. This means there is one data point for each year 
that the series covers. The period can be any value from 1 to 99. 
Typical values are 1 (annual), 4 (quarterly), 12 (monthly), and 
30 (daily). 

START: This is the starting date for the series. The first data item is for 
the year 1973 in both of the listed series. If the period was some­
thing other than I, the starting date would include the year 
and the period of the first data point. For example, a starting 
date of 1980 9 with a period of 12 means the 9th period of 1980 
or September, 1980. 
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END: 

#: 

This is the ending date for the series. Everything mentioned 
in the description of START applies to END. 

This is the number of data points in the series. A series can 
hold a maximum of 150 data points. 

You must select a series from this list. You cannot go further in the Plot 
program unless there is data to plot. Selecting an item from a list is not 
much different than selecting from a menu. You simply move the cursor to 
the item and press the RETURN key. 

Play with the cursor in this list. Note that the right arrow key moves the 
cursor down the list and the left arrow key moves it up the list. Also note 
that the cursor wraps around the list. If you try to go beyond the bottom 
line of the list, the cursor jumps to the top item. Likewise, attempting to go 
beyond the top of the list causes it to jump to the bottom. The wrap around 
feature lets you move around a long list very rapidly. 

F or the purposes of this lesson, move the cursor to the series named 
FLOPPY SALES. Press RETURN. 

THE MAIN PLOT MENU 

The list of series is erased and a new menu appears in the status area at 
the bottom of the screen. This is the Main Plot menu. Most of your work 
with the Plot program is done from this menu. 
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Look at the status area; there are a couple of new items in it. The bottom 
line, which was blank in the previous menu, now says FLOPPY SALES/LINE 
on the left side and W1 .81 on the right side. 

You probably remember that the items on the left side repeat the selec­
tions you made from the last menu and list. You chose to draw a LINE 
chart and selected the series named FLOPPY SALES. 

The meaning of the cryptic notation on the right is quite simple, it speci­
fies the colors in which the chart will be drawn. WI says the foreground 
of the chart, the actual data, will be drawn in white. BI says the back­
ground will be black. You can change the colors and will have a chance 
to do it later. The program always puts a single series chart in black and 
white. The program does not know if you have a color or black-and-white 
monitor. Black and white shows up very well in both types of monitors. 

The cursor is pointing to the word PLOT and the top line of the status 
area says PLOT THE CURRENT SERIES. The current series is the last series or 
group of series chosen from the list. Selecting a series makes that series 
the current series. You can select more than one series and then they all 
become the current series. Selecting multiple series is described in Lesson 
Four. 

Move the cursor around the menu and read the long prompts for the 
other items. Don't press RETURN yet. When you are done looking over 
the Main menu, move the cursor back to the word PLOT. 

DRAWING THE CHART 

With the cursor on PLOT, press RETURN. As the long prompt says, this 
function draws a chart of the current series. 

When you select PLOT, the menu in the status area is replaced with 
SCALING ... In a few moments SCALING ... is replaced with PLEASE WAIT ... 
You also hear a sound from the computer. The beep is just an added indi­
cation that the computer got your command and is processing it. There is 
another beep when it completes the chart. 

The Plot program draws the outline of the chart, the Y-axis and the 
X-axis, and puts the values at the tick marks. At this point the status area 
disappears and the data is plotted within the chart. Finally, the legend is 
printed across the bottom and the second beep indicates that the PLOT 
request is completed. The screen should now look like the following 
photograph. 
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Examining the chart. The numbers along the vertical or Y axis are the 
scale of the chart. The numbers along the horizontal or X axis are the 
range. Remember that the series listing said this series covered the years 
1973 through 1984. The numbers along the X-axis are 73, 75, and so forth. 
When the range is given in years and there are many plotting points, the 
Plot program abbreviates the range numbers to fit on the axis. 

The line under the X-axis is the legend. The legend contains the name 
or names of the plotted series and, in the case of line charts, shows what 
plotting symbol is used for the particular series. In this example, the 
plotting symbol is a square box with a dot in the center. This symbol is 
always used when a single series is plotted. Later, when you draw charts 
with multiple series, you will see the other symbols: the diamond and the 
pound sign. 

The main attraction of the chart is the plotted data. There is a plotting 
symbol for each of the 12 data points in the series. The points are con­
nected by a line. 

HOW TO CONTINUE 

Up to this point, there has been a menu on the screen or some directions 
telling you what you can do. With the menu you always knew you could 
do something. Now there is nothing but a chart; there isn't even a cursor. 
Of course you do not want to stop after making a single chart. The VisiPlot 
programs are menu driven and you cannot do much without a menu. To 
set the menu back, press any key on the keyboard except RESET. 
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No matter what you press, the status area reappears and covers the 
legend. The full chart is still visible above the status area. The status area 
contains the same menu you used to draw the chart, the Main Plot menu. 

If you want to see the chart again without the status area, press the ESC 
key. The status area is erased and the chart legend reappears. You can 
switch back and forth as often as you want. Any key brings the status area 
back and the ESC key erases it. These functions work whenever there is 
a chart on the screen. 

DRAWING A BAR CHART 

If the status area is not on the screen, display it by pressing any key 
except RESET. There are many things you can do to the chart with the 
other functions in the Main Plot menu. You can put titles on it, change 
the range and scale, put grid lines on it, and much more. Before looking 
at these features; you should practice what you just learned by drawing 
a different kind of chart. You are going to start over and repeat what you 
did to draw the line chart. The difference is that you are going to draw a 
bar chart. 

Move the cursor to the word SELECT. The long prompt says SELECT A 
GRAPH BY TYPE. Press RETURN. 

As you probably expected, the status area changed and the Select 
menu is displayed. The line chart is still on the screen. You can still erase 
the status area with the ESC key to display the whole chart and legend. 

Move the cursor to BAR. The long prompt says DRAW VERTICAL BARS. 
Press RETURN. 

Instead of the list of series, the status area changes and the Bar menu 
appears. Here you have to select the style of bars with which you want the 
chart drawn. The choices are NORMAL, LEFT, and RIGHT. LEFT and 
RIGHT are used for comparison charts. Lesson Four shows their use. The 
LEFT and RIGHT bars are half the width of the NORMAL bars and 
appear to the left or right of the tick marks. Make sure the cursor is on 
NORMAL and press RETURN. The normal, or full-width, bars are 
centered on the X-axis tick marks. The photographs show the Bar menu 
and the full- and half-width bars. 
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Now the list of data series is displayed. Again select FLOPPY SALES and 
press RETURN. 

As before, the list is erased and the status area changes to the Main 
Plot menu. The last chart, the line chart of FLOPPY SALES is again dis­
played. The old chart is kept on the screen until you PLOT the new chart. 
Look at the bottom line of the status area, you will see that it now reads 
FLOPPY SALES/BAR. 

Make sure the cursor is on PLOT and press RETURN. 

The line chart is erased and the sequence you saw earlier is repeated: a 
sound from the computer, SCALING"" PLEASE WAIT"" the chart is drawn, 
and finally the sound indicating the chart is completed. 
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THE PLOTTING OPTIONS 

The chart on the screen is quite Spartan. In some instances this chart 
would be perfect. But for most applications, you will want to include more 
in the chart. You might want a title that is more descriptive than the 
legend. You might want to explain the values on the Y-axis. You might 
want to highlight some detail in the chart or explain some detail such as 
the drop in sales in 1982. 

Press any key to display the status area. 

The menu item immediately under PLOT is OPTIONS. Move the cursor 
to OPTIONS and press RETURN. The menu in the status area changes. 
This is the Options menu. You are going to use all of these options in this 
lesson. . 
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Move the cursor around the menu and read the long prompts; they 
give you a brief idea of what each option does. When you are done 
examining the menu, move the cursor back to TITLE and press RETURN. 

Putting Titles on a Chart 

The status area again changes menus. This is the Title menu. This 
menu does not display long prompts in the top line of the status area. The 
items are descriptive and you won't have any trouble understanding them. 
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The first item is EXIT. EXIT provides the means of getting out of this menu. 
The other items in the Title menu perform their function and then return 
to the Title menu. EXIT returns you to the Main Plot menu, not to the 
Options menu. Give it a try. To get back to the Title menu, you must 
select OPTIONS and then TITLE. 

Move the cursor to TOP and press RETURN. 

The status area changes. The menu vanishes and the second line 
contains the word ENTER. The third line is empty. This is a configuration 
you will see often. It means the VisiPlot program wants you to enter some 
data at the keyboard. The data you enter at the keyboard appears in 
the third status area line. 

Type MY FIRST CHART. If you make a mistake, press the ESC key. 
ESC erases the last character on the line. Press ESC. If the last character 
was a space, you won't see anything happen. Press ESC until you see 
the erasing action of the ESC key. If you press ESC past the beginning 
of the data, the program returns to the Title menu. 

Anytime you have to enter data, the ESC key lets you correct your 
mistakes or change your mind. If you try to correct the line by pressing 
the left arrow key, you will hear a beep from the computer indicating 
that the use of the key is not valid. 

When you finish entering the title, press RETURN. A two item menu 
appears. You have the choice of displaying your title in normal typeface 
or bold typeface. Everything you have seen written on the screen so far 
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has been in the normal typeface. Move the cursor to BOLD and press 
RETURN. 

The title appears centered at the top of the chart. Notice that the char­
acters are much bolder than the other characters on the screen which 
are in the normal typeface. 

You can enter a top title as long as 38 characters. If you change your 
mind and want a new top title, just enter a new one. The new title will 
replace the old one. 
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The 'Title menu reappears at the bottom of the screen after the top title 
is completed. 

Notice that the menu allows you to enter one, two, or three bottom 
titles. The bottom titles use the same area used by the legend. A bottom 
title erases the legend line if there is a legend line at the specified location. 

Move the cursor to BOTTOM1 and press RETURN. Again you are con­
fronted with the status area configuration that requests alphanumeric 
data. Bottom titles can also be 38 characters long. Enter the title DISK 
DRIVE SALES. When you press the RETURN key, the typeface menu 
again appears. This time select the NORMAL typeface. After you select 
the typeface, the legend line is overwritten by the title and quickly the 
status area reappears. Press the ESC key to erase the status area and 
take a better look at the bottom title. Press any key when you are ready 
to continue with the lesson. 

Move the cursor to LEFT and press RETURN. The Left title can be 18 
characters long. Enter UNITS PER OUTLET. When you press RETURN 
the line is displayed vertically along the left side of the chart, outside 
the Y-axis scale values. The typeface menu was not displayed. The LEFT 
title is only available in the normal typeface. 

The last item in the Title menu is MOVEABLE. The MOVEABLE function 
provides the means of entering a title and moving it to any location in 
the chart. With the MOVEABLE function you can put as many titles as you 
want anywhere in the chart; there is no limit. 

Move the cursor to MOVEABLE and press RETURN. 

Enter PLANT FIRE and press RETURN. 

The entry appears at the middle left of the plotting area and blinks 
at a steady rate. This title can now be moved to any location on the 
screen. It will continue to blink until it is fixed in a permanent location. 
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Moving a Title 

The movement of a title is controlled with the I, J, K, and M keys. 
Look at these keys on the keyboard and you will notice that their relative 
locations suggest the four screen directions: 

UP 

Iccl 
LEft ICDI ICKJI RIGHT 

~ 
DOWN 001-004 

Press and release the K key and the blinking title slowly moves to the 
right. You can stop it at any time by pressing the space bar. Try it. To 
start it moving again, press any direction key. While the title is moving, 
you can change its direction by pressing a different direction key. There 
is no need to stop it to change direction. Press the M and let the title 
move down over the chart bars. Notice that it is white when over a black 
background and black when over a white background. Let it continue 
to the bottom of the screen. As it passes over numbers and letters, it is 
difficult to read. But you can always tell where it is by the blinking. 

When it reaches the limits of the screen, it keeps trying to move and 
the computer beeps for each attempted move. The beeping continues 
until you stop the movement by pressing the space bar or change the 
direction by pressing another direction key. 

You can increase the speed of the title movement with the number keys, 
1 through 9. The higher the number the faster the title moves. If you do 
not choose a speed, it travels at the 1 rate. 

Press 9, the fastest speed. The title continues in the direction it was 
moving but at a faster rate. If it was stopped, it begins moving again, in 
the direction it was last moving. 

With a little practice, you will become adept at moving the title quickly 
to an area of the screen at high speed and then fine tuning the position 
at a slower speed. 

Move the PLANT FIRE title to the short bar for the year 1982. Center it 
across the bar about a quarter of an inch from the top. When you have it 
where you want it, press RETURN to fix it in place. 
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When you press RETURN, the title stops blinking and appears in reverse 
video, black letters on a white background. Press the space bar and the 
title changes, it is now in white letters on a black background. You can 
continue to switch back and forth between normal and reverse video by 
pressing the space bar. When you decide on the style you prefer, press 
RETURN again. The title is now a permanent part of the chart and the 
Title menu returns to the screen. The only way to change it now is to redraw 
the chart. 

Until you pressed the RETURN key the second time, the MOVEABLE title 
could have been erased by pressing the ESC key. 

You learned several things in this section: 
• The I, J, K, and M keys move a moveable title in the direction indicated 

by their relative location. 
• The number keys, 1 through 9, select the speed at which the title moves. 
• Pressing the RETURN key once fixes the title in its current location. 
• The space bar switches the title between normal and reverse video. 
• Pressing the RETURN key the second time makes the title a permanent 

part of the chart and returns the Title menu. 

Erasing Moveable Titles 

A MOVEABLE title can be erased at any time by pressing the ESC key 
before the RETURN key is pressed the second time. 
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Enter another MOVEABLE title. Move the cursor to MOVEABLE, press 
RETURN, enter JUNK, and press RETURN again. Move the title to a loca­
tion over the bars and stop it. 

Now press ESC. The title vanishes and no harm is done to the bars that 
were under it. 

You can erase the MOVEABLE title after it is fixed in place but before the 
second RETURN that makes it a permanent part of the chart. After the 
title is fixed in place (by the first RETURN), erasing it also destroys 
whatever is under it. If you had fixed it in place by pressing the RETURN 
once and then pressed ESC, there would have been a rectangular hole in 
the bars where the title had been fixed. 

After the second RETURN, the title cannot be erased. 

Bringing Back the Legend 

The only items remaining in the Title menu are BOnOM2, BOnOM3, 
. and LEGEND. BOnOM2 and BOnOM3 function just like BOnOM 1 except 
that they put titles on different lines. 

LEGEND erases any bottom title lines that cover legend lines and 
restores the original legend lines. Like bottom titles, there can be a 
maximum of three legend lines. Only those bottom title lines that covered 
a legend line are erased, the others remain on the screen. You covered 
the one line legend with the BOnOM1 title. Press RETURN while the 
cursor is on the LEGEND item. 

Very quickly the status area vanishes, the bottom title is erased, the 
legend line is restored, and the status area returns and covers the legend. 
This -happens fast and you might miss it. Press the ESC key to erase the 
status area. Your bottom title is gone and the original legend is on the 
screen. 

Just as a note now, it should be mentioned that the LEGEND function 
works differently with pie charts. When you have a pie chart on the 
screen, the LEGEND function erases the pie chart legend. After the pie 
chart legend is erased there is no way, short of redrawing the chart, to 
reconstruct it. 

Move the cursor to EXIT and press RETURN to return to the Main Plot 
menu. 
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The Scale and the Range 

The range of a chart is the time between the starting date and the ending 
date and is always plotted on the X-axis (except for a scatter chart). The 
range is stored as part of the data series. The scale is the spread of values 
plotted along the Y-axis. The program determines the scale each time a 
series is plotted. It determines a reasonable scale that covers the range of 
values in the series. It also decides on the number of divisions (tick marks) 
to display. 

In determining a scale, the program attempts to avoid divisions that 
result in fractional or non-round numbers. When possible, it chooses 
round numbers. For example, with a series that spans the values 0 
through 700, the program divides the Y-axis into seven divisions and 
labels them 0, 100, 200, ... , 700. It wouldn't choose ten divisions because 
that results in scale labels of 0,63, 127, 190,254, and so on. 

When the Y-axis values are too large to be displayed, the VisiPlot 
program scales the values up or down by a power of 10. It then displays 
the Y-axis scaling factor at the top of the Y-axis in reverse video (black 
on white). For example, with a scale of 0 through 100,000, the 
program generates labels of 0, 10, 20, 30, values are multiplied by 10 to 
the 3rd power or 1000. The following photograph shows a chart with a 
scale factor. 

You can change both the range and the scale when you draw a chart. 
You might want to show only a subset of the range. You might want small 
variations to show up more or to show up less. The scale and range have 
a significant effect on how a person perceives the data in a chart. 
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How to Change the Scale 

We will use a different chart for this portion of the lesson. Go back to the 
Select menu, specify a LINE chprt, and select the series FLOPPY 
DENSITY. 

If you forgot, SELECT takes you back to the Select menu. LINE specifies 
a line chart. FLOPPY DENSITY is one of the series on the list. When the 
Main Plot menu returns, select PLOT and draw the new line chart. 

Press any key to bring back the status area after the chart is drawn. 
Select the Options menu again with the OPTIONS item in the menu. 

One of the items on the Options menu is RESCALE. Move the cursor to 
RESCALE and press RETURN. 

The status area configuration that requests data appears in the status 
area. The prompt asks for a Y-AXIS MINIMUM. The current minimum used 
in the chart is a, change it to -200. Enter -200 and press RETURN. 
Next you are prompted for the Y-AXIS MAXIMUM. The maximum is 
currently 200, change it to 100. Enter 100 and press RETURN. Finally, you 
are prompted for the # AXIS DIVISIONS (2... 12). You can specify any 
number of divisions from a minimum of 2 to maximum of 12. The new 
scale, -200 to lOa, divides nicely into 6 divisions. Enter 6 and press 
RETURN. If you do not enter a valid number, the RESCALE operation is 
canceled. 

To determine the number of divisions, subtract the mInlmUm scale 
value from the maximum value. A good number of divisions is any 
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number in the range 2 through 12 that evenly divides into the difference. 
In the above example, 100 minus -200 equals 300. 2, 3, 6, and 12 give 
divisions of ISO, 100, 50, and 25. Others, such as 4 and 5, will work but 
result in divisions of 75 and 60 which are not as common as chart units 
as 25, 50, and 100. 

The Main Plot menu returns but nothing else happens. The scale did 
not change. 

You didn't do anything wrong. You must select PLOT again to redraw 
the chart with the new scale. Press RETURN with the cursor on PLOT. 
After the PLEASE WAIT ... message, there is a beep from the computer and 
the message DATA OFF SCALE: Y TO DISPLAY appears in the status area. 
This message means that there are data points in the series that are 
outside the scale you specified. This is just a warning that the chart will 
not contain all the data points in the series. If you press th~ Y key the 
program continues and draws the chart. If you press any other key on 
the keyboard, the PLOT request is canceled. 

Press Y to continue. For each data point that the program cannot put on 
the chart, it sounds a beep. There are two beeps that are sounded while 
the program draws this chart. The last two points in the series do not fit 
within the scale. 

This situation holds true for line, area, scatter, and hi-Io charts. How­
ever, if you attempt to draw a bar chart that goes off the scale, the program 
stops at the first off-scale bar. The drawing of the chart is terminated with 
the message CAN'T! PRESS ANY KEY. If you think about it, an off scale bar 
chart actually gives incorrect information. The person reading the chart 
doesn't know that certain bars should continue beyond the top of the 
scale. It is better to rescale and try again than to show incorrect informa­
tion. 

Confusing the VisiPlot Program 

You can try to confuse the program by giving a minimum scale value 
that is greater than the maximum value. The program assumes that you 
reversed the values and switches them back. If you give the same value 
for the minimum and the maximum, the program uses this value as the 
minimum and sets the maximum approximately 20 percent higher. 

If you give a number of divisions less than 2 or greater than 12, the value 
is not accepted and a beep is sounded. The program then waits for a valid 
number. If you don't enter any number, that is, just press the RETURN 
key, the RESCALE request is canceled. 
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Aesthetic Charts 

The VisiPlot program does its best to generate a good scale for your 
chart. There are times, however, when the values it chooses turn out 
poorly. When this happens, you should consider rescaling the chart. 

When you select a scale, the program takes your request literally and 
does not try to change it. You will, at times, come up with some odd­
looking scales. This is especially true if you select a number of Y-axis 
divisions that are not an even divisor of the difference between the 
minimum and maximum scale values. For example, if you set a scale from 
-200 to 800 with 10 divisions, the labels read -200, -100, 0, 100 and 
so on. But if you pick a scale from -212.39 to 643.22 with 9 divisions, the 
chart, while correct, is quite unaesthetic as you can see in the following 
photographs. 
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How to Change the Range 

Let's start with an unchanged version of the FLOPPY DENSITY series. 
You can choose whether to go back to the Select menu and get a fresh 
copy of the series or change the scale back to 0 to 200 with 10 divisions. 
If you need help with your choice see either "The Select Menu" or "How 
to Change the Scale~' 

Now you should have a FLOPPY DENSITY line chart on the screen 
that looks like the following photograph. 
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Move the cursor to OPTIONS again and press RETURN. 

Now move the cursor to RANGE and press RETURN. 

The status area changes. The top line reads RANGE: 1973 TO 1981. The 
RANGE menu offers three choices: SET, CLEAR, and EXIT. 

EXIT returns you to the Main Plot menu. 

The SET option specifies that you want to change the range. With the 
cursor on SET, press RETURN. The data input configuration of the status 
area appears. The prompt asks for the MAJOR START (YEAR). Enter 1974 
and press RETURN. The program now prompts for the MAJOR END 
(YEAR). Enter 1990 and press RETURN. The Main menu returns and 
nothing happens to the chart. Just as you did with the RESCALE option, you 
must select PLOT to see the chart with the new range. With the cursor 
on PLOT, press RETURN. 

You took a year off the front of the series and added nine years to the 
end. You can lengthen or shorten a range. As you change the range and 
·take out data points, you might change the scale. If you specify a range 
that does not coincide with any of the data points, you get the message 
CAN'TI BAD RANGE. A new range must overlap the range of the series 
by at least one point. If there is only one point on the chart it is plotted 
with a single dot and no line. 
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When the program prompted for start and end dates it did not ask for a 
period. If the period is other than 1 (annual), the program prompts for the 
year and the period for both the start and the end dates. 

Select the Options menu again and then the RANGE option. This time 
move the cursor to CLEAR and press RETURN. When the Main menu 
returns, PLOT the chart again. This time it is drawn with the original 
range. 

The CLEAR function removes a user-defined range and returns to the 
range stored in the series. The CLEAR function does nothing if you have 
not changed the range. 

The Interplay Between Scale and Range 

When you change the range of a chart, the scale is automatically 
recalculated for the data points within the new range. If you change the 
scale with the RESCALE function before changing the range, the VisiPlot 
program does not perform any scale recalculation. 

More About Ranges 

The program calculates the range before it draws a chart. When only 
one series is selected, the resulting range is the range of that one data 
series. But if two or more series are selected, the calculated range is either 
the union or intersection of the ranges of the individual series depending 
on the type of chart. 

The union of ranges means that the earliest starting date and the latest 
ending date are used. The union of ranges is used with line and area 
charts. The interaction of ranges means that only those dates that are 
common to both (or all) series are used for the chart range. The inter­
section of ranges is used with bar, hi-Io, and scatter charts. 

The maximum number of points allowed in a range is 150 and the 
minimum is 2. If you try to draw a chart from a set of series whose com­
bined range has more than 150 points, you will get the error message 
CAN'TI BAD RANGE. 

Formatting a Chart 

Display the Main Plot menu (press any key if the status area is not on 
the screen) and select NEW. NEW erases the existing chart and clears all 
options you have set. If you do not select NEW, some options such as 
COLOR and BACKGR, are held over from chart to chart. 
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Now select LINE and the FLOPPY SALES series. PLOT it. Notice that the 
program draws a line chart with plotting symbols and lines connecting 
the symbols. 

Select OPTIONS. Move the cursor to FORMAT and press RETURN. The 
Format menu is displayed. The choices are SYMBOLS, LINES, and BOTH. 
All the line charts you have drawn used both symbols and lines. 

Move the cursor to LINES and press RETURN. The Main menu returns. 
Now PLOT the chart again. It is redrawn without the plotting symbols­
just the lines connect the plotted points. 

Go back to the Format menu (select FORMAT from the Options menu) 
and choose SYMBOLS and redraw the chart again. This time it is drawn 
with the plotting symbols but no interconnecting lines. 

These are the FORMAT options for a LI N E chart. The FORMAT option is 
only valid for LINE, BAR, and SeADER charts. The BAR chart options let 
you select solid bars (like the bars used in the chart you did earlier in the 
lesson), outlined bars, or shaded bars. The SeADER chart options are to 
plot with points or symbols. No lines are drawn in a scatter chart. The 
following photographs show the BAR and SeADER chart formats. 
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If you try to select the FORMAT option with any kind of chart other than 
LINE, BAR, or SCADER, you will get the message CAN'TI NO OPTION HERE. 

You might try the FORMAT options with the BAR and SCADER charts 
now. 

Drawing Grid Lines 

Go to the Select menu by selecting NEW. NEW cancels all options set 
through the use of the Options menu. Then select LINE, either of the series, 
and finally PLOT. 

Select the OPTIONS item and move the cursor to GRID and press 
RETURN. The Grid menu appears. This menu offers the options of draw­
ing horizontal, vertical, or both horizontal and vertical grid lines. With the 
cursor on BOTH press RETURN. The program draws the grid lines for 
every tick mark that has a label. 

PLOT the series again. There is no need to go to the Select menu, just 
press RETURN with the cursor on PLOT. The program redraws the chart 
without the grid lines. Go to the Grid menu again and draw only the 
horizontal grid lines. 

Go back to the Grid menu once more and select HORIZ. The program 
erases the existing grid lines. This feature operates on the horizontal and 
vertical grid lines. Note that only the grid lines are erased; the added 
lines on the top and right are not erased. 
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You do not have to erase grid lines in the same manner that you drew 
them. You can draw both horizontal and vertical and then erase only one. 
You can later redraw an erased set of grid lines. 

A chart (other than a pie chart) must be displayed when choosing the 
GRID option. If you select the option when no chart displayed, you get 
the CAN'TI NO OPTION HERE message. 

PRINTING THE CHART 

You can print a copy of the chart on a hard copy printer if you have one 
of the supported printers connected to the computer. Before you can print 
a chart, you must have initialized the printer driver as described in the 
section "Printer Support" in the Introduction. 

To print a copy of the chart that is on the screen, move the cursor to 
PRINT and press RETURN. If you have not used the printer during this 
session (which you haven't if you are following the lesson for the first time) 
the program prompts for slot number to which the printer is connected. 
Usually, the printer is connected to slot 1. Enter the slot number and press 
RETURN. The program immediately proceeds to print the chart on the 
screen. 

THE END OF THE BASICS 

You now have enough experience to examine the remainder of the 
OPTIONS menu. There are three options you haven't used: UNLABEL, 
BACKGR, and COLOR. These options erase the labels around the chart, 
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change the background color, and change the plotting color. There are 
also two options in the Main Plot menu that you have not used: - > MAIN 
and PIXSAVE. These options reload the Storage Management pro­
gram and save a binary copy of the screen image in diskette. 

UNlABEL must be used with a chart displayed, like the GRID option. 
Once you erase the labels with this option, you must redraw the chart to 
get them back. 

The BACKGR and COLOR options are most useful if you have a color 
monitor. See the descriptions of these options in the Reference Section 
of this manual. 

The - > MAIN option prompts with the NPE Y TO CONFIRM message 
and reloads the Storage Management program if you press the Y key. 
Any other key cancels the request. The data series that you have in 
memory are not lost when you change programs. 

The PIXSA VE option save the screen image in a diskette file in binary 
form. You are prompted to enter a name for the PIXSAVE file. The file is 
stored under that name with .PIX added to it. This binary file can be 
printed at a later time with a program you must supply to match your 
printer. Appendix A contains a sample of such a program. 

The next lesson describes the use of the Storage Management program. 
Following that, Lesson Three covers the Edit functions. 
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LESSON TWO 

UffiNGTHE STORAGE MANAGEMENT PROGRAM 

This lesson describes the facilities of the Storage Management progrqm, 
except for the Edit functions which are described in Lesson Three. Lesson 
Two gives you experience and practice using these functions. 

Storage Management is the first program you encounter after booting 
from the VisiPlot program diskette. Along with creating, loading, and 
saving VisiPlot data, the Storage Management facilities provide access 
to DIF data from other Personal Software products, such as the VisiCalc 
program. With DIF files, you can create and modify data with the VisiPlot 
facilities and then process that data with other products. 

In the last lesson, you used a couple of the Storage Management func­
tions. Depending on your experience with computers, you mayor may 
not have known what you were doing. In this lesson you will do more and 
also get a full explanation. 

IF YOU ARE IN THE PLOT PROGRAM 

If you are still in the Plot program from Lesson One, display the Main 
Plot menu. To get to the Main Plot menu: 
• press any key if there is no menu displayed. 
• from the Select menu, select NONE. 
• from the Options menu, select TITLE and then EXIT. 
• from the Title menu, select EXIT. 

To return to the Storage Management program, select ->MAIN. You 
are prompted to press the Y key to verify that you want to change 
programs. 

IF YOU ARE NOT IN THE PLOT PROGRAM 

Load the Vi siP lot program according to the directions in the "Loading 
the VisiPlot Program" section in the Introduction. 

THE MAIN STORAGE MANAGEMENT MENU 

After loading the program, the Main Storage Management status area 
appears at the top of the screen. The version number of your VisiPlot 
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diskette, the copyright notice, and some general directions on using the 
men u follow. 

The Main Storage Management menu lists most of the functions avail­
able in the Storage Management program. Move the cursor through the 
menu items and read the long prompts on the top line of the status area. 
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DATA AND PROGRAM DISKETTES 

The bottom line of the Main Storage Management menu lists a slot and 
drive number. These items specify to which disk drive the program goes 
when asked to load or save data. 

The slot number is the address of the boot slot on the main circuit board 
(the Apple II mother board) where the disk drive controller is plugged. 
The drive number is either I or 2, identifying one of the two drives that 
can be connected to the disk drive controller. The diskette in the disk 
drive identified by these fields is called the data diskette. The diskette 
on which the program is stored is called the program diskette. 

A single diskette can serve both purposes, but it is best to use a separate 
diskette for your data. To use the program diskette, you must remove the 
write protect tab. The use of the program diskette for data, increases the 
possibility of accidentally destroying the VisiPlot program on the diskette. 
Your VisiPlot program diskette contains the VisiPlot programs and some 
sample data series for practice. You used one of the files, SAMPLE 1, in 
Lesson One. 

HOW THE DATA DISKETTE DRIVE IS SELECTED 

When you load the VisiPlot program, it determines where the data 
diskette is located. First, it assumes the data diskette is located at the 
same slot address from which you loaded the program. Normally this is 
slot number 6. 
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The specific drive can be number 1 or 2. If you have a single drive 
system or only one drive connected to the disk controller from which you 
loaded the system, the data diskette drive is number 1. If you have two 
drives connected to the controller in the boot slot, the data drive number 
may be number 1 or 2. When you load the VisiPlot program, part of the 
program initialization checks if there is a diskette thast is initialized for 
use with the VisiPlot program in drive 2. If there is, drive 2 is assigned as 
the data diskette drive. If there is no diskette in drive 2, or if the drive 2 
door is open, or the diskette in the drive is not initialized, drive 1 is 
assigned as the data diskette drive. 

For the purpose of this lesson, load the VisiPlot program without a disk­
ette in drive 2. If you have already loaded the program with a diskette 
in drive 2 and the bottom line of the status area says DRIVE: 2, do the 
following: 

• Move the cursor to DRIVE 
• Press RETURN 

This is all it takes to change the data diskette drive assignment. 

Now double check and make sure the bottom line of the status area 
reads: 

SLOT: 6 DRIVE: 1 

The slot number, of course, is whatever slot you load from. 

LOADING VISIPLOT DATA 

There are two ways to get chart plotting data into the computer. You 
can create it with the Edit function (which is described in Lesson Three) 
or you can read it from diskette. 

The data on diskette was originally created with the Edit function or 
transferred from some other program as a DIF file. The use of diskettes 
is a convenience. With them, you can save the plotting data and use it 
later. Without them, you would have to recreate the data over and over, 
each time you load the VisiPlot program. 

After you load the VisiPlot program 'and the Storage Management 
menu appears, the cursor points to the LOAD function. The long prompt 
reads LOAD SERIES. 

With the cursor on LOAD, press RETURN. 

The menu disappears and the message READI~~G DIRECTORY ... 
temporarily appears in the status area. The disk drive motor begins to 

2-35 



VISIPLOT™ ~t~~f APPLE II 
LESSON TWO TUTORIAL 

run. The message in the status area is replaced with < -, - >, SPACE BAR, 
OR RETURN, and a list of names appears under the status area. The cursor 
is no longer in the status area, it is pointing to the top name on the list. 

The names on the list are the VisiPlot files on the data diskette. In this 
example, the data diskette is also the VisiPlot program diskette. This 
method is used only to supply data for these lessons; you should not put 
your data on the program diskette. There may be other files on the diskette, 
but the program only lists text files such as VisiPlot or DIF files. (You may 
encounter a data diskette that contains other text files such as VisiCalc/ 
SS files. If you try to load a non-VisiPlot of DIF file, you will get the 
UNABLE TO LOAD: WRONG FORMAT message.) Each VisiPlot file contains 
from 1 to 16 data series. There will be more about files and series shortly. 

You select a file for loading by pressing RETURN or the space bar with 
the cursor pointing to the file name. As described in the Introduction, 
the cursor moves up and down the list when you press the left and right 
arrow keys. 

The last item on the list is (NONE). Selecting (NONE) lets you go back to 
the Main Storage Management menu without loading a file. You may 
need this when you use the LOAD function simply to look at the file list 
or when you accidentally select LOAD. 

If the whole list of files does not fit on the screen, the last item will be 
(MORE). Selecting (MORE) displays the next portion of the list. You are at 
the end of the list when the last item is (NONE) and (MORE) no longer 
appears on the list. 
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To start from the top of the list again, select (NONE) and, when the Main 
Storage Management menu reappears, select LOAD again. 

The next sections of this lesson assume that the two series in the file 
SAMPLE 1 are in memory. If you did not leove the VisiPlot program after 
finishing Lesson One, these series are still in memory and you should 
skip to the next section, "Listing the Series in Memory~' If you just loaded 
the program, continue with the next paragraph. 

Move the cursor to the name SAMPLE 1 and press RETURN. 

The message vanishes from the status area and the disk drive motor 
runs again. Characters rapidly flash across the third line of the status 
area. This is the data being loaded from the diskette. After the file is 
loaded into memory, a list of the series in the file is displayed. You have 
the option of CONTINUEing, which returns the Main Storage Management 
menu, or PRINTing, which prints the list on your printer and then returns 
to the Main Storage Management menu. Select CONTINUE. 

You can only load one file at a time. However, you can select LOAD 
again and read another file into memory. Memory can hold a maximum 
of 16 data series or 645 data points, whichever is reached first. If your files 
each hold four series that average less than 40 data points each, you 
could load four files into memory. If you have a file with one series that 
contains 645 data points, you could only load the one file. 

When the memory limit is reached, the message NO MORE ROOM 
appears on the screen. If the data is in the normal VisiPlot format, a partial 
load is done, if there is sufficient room in memory. The error message 
still appears. 
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LISTING THE SERIES IN MEMORY 

You just loaded a file named SAMPLE 1. 

Move the cursor to LOOKUP and press RETURN. 

The long prompt reads DISPlAY INFO ABOUT SERIES. A list of two items 
appears under the status area, it is the same list you saw when you loaded 
the file. Most of the list should look doubly familiar. It is the same list you 
saw when you selected a series for plotting in the Plot program in Lesson 
One. 

If your screen does not look like the photograph, you either loaded 
the wrong file or had previously loaded series in memory. If this occurs, 
select CONTINUE, move the cursor to CLEAR and press RETURN. Move 
the cursor to (KEEP NONE) and press RETURN. This clears all series from 
memory. Now go back to the section "Loading VisiPlot Data" continue 
from that point. If your screen looks like the photograph, continue with the 
next paragraph. 

Just to review, the columns in the list are the names of the series, the 
period of the data (the frequency of data points per year), the starting 
date, the ending date, and the number of points in the series. 

This list has an additional line at the bottom that was not present in the 
Plot program list. It reads: 

SERIES: 2/16 DATA POINTS: 21/645 
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This line shows how much room is occupied. Memory holds a maxi­
mum of 16 series or 645 data points. You loaded two series from the file 
SAMPLE 1. That leaves room for 14 more. The two series contain, respec­
tively, 12 and 9 data points for a total of 21. Memory can hold a maximum 
of 645 data points; there is room for 624 more data points. 

When you are done examining the LOOKUP list, select CONTINUE to 
return to the Main Storage Management menu. Alternately, you may 
select PRINT to print a copy of the list before returning to the Main Storage 
Management menu. 

FILES AND SERIES 

Some users, especially those who are new to computers, get confused 
about files and series. 

The VisiPlot program uses floppy diskettes as a permanent storage 
medium. On these diskettes, the program stores data, any kind of data, in 
units called files. A file is nothing more than a collection of data that is 
identified by a name called a file name. 

When the VisiPlot program processes data in the computer, it uses a 
unit of data called a series. A series is a collection of data points for a 
single chart. A series has a name and is identified by that name, just like a 
file. The figure shows the relationship between files and series. 

o ___ -----~ FILE - f 

-0 FILE-( 

FLOPPY SALES 

flOPPY DENSITY 

DIAMONDS 

INFLATION 

lC RUBY 

2C RUBY 

3C SAPPHIRE 

SERIES. 

SERIES 

SERIES 

SERIES 

SERIES 

SERIES 

SERIES 

001-005 

After a file is brought into memory, the series in the file have no further 
connection with the file. They become independent units. 

Often there are several series with related data that are used together. 
For example, for a business you might have series showing sales, costs, 
gross and net profits. You might have data to shwo the breakdown for a 
whole year and also yearly or quarterly data to show growth over the past 
several years. 
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All this data is related and probably used together. Many of these series 
would be plotted on the same chart. Rather than store each series as a file, 
the VisiPlot program provides the means of combining up to 16 series (or 
series containing up to 645 data points) in the offline storage unit-the 
floppy diskette file. To access the data for these series, either for updating 
or plotting, you load a single file instead of many files. 

The points to remember are: 
• Both files and series have names 
• Files are units of storage on diskettes 
• Series are units of data in memory 
• A file can hold up to 16 series or 645 data points 

CHANGING THE DATA DISKETTE ADDRESS 

It was mentioned in the beginning of this lesson that the VisiPlot 
program determines the slot and drive address for the data diskette. 
Many times you may want to change the address. You may have for­
gotten to put the data diskette into drive 2 when loading the program. 
You may have more than two drives and want to use drives not con­
nected to the same slot as the drive from which you loaded. There are 
many circumstances in which you will have to change the address. 

The program lets you change the slot and drive addresses indivi­
dually. 

Changing the Drive Address 

To change the data diskette drive address, move the cursor to DRIVE 
and press RETURN. The drive number in the bottom line of the status 
area changes. If it was 1 it changes to 2 and if it was 2 it changes to 1. 

Remember, the LOAD, SAVE, DELETE, and INIT functions read (load) and 
write (save) to the data diskette in the specified drive and slot. The 
PIXSAVE function in the Plot program also uses this drive and slot. 

After the change the cursor returns to its initial position at LOAD. 

Always check the drive and slot numbers before issuing a function that 
uses the data diskette slot and drive addresses change them if necessary. 
If you try to LOAD from a non-existant or empty drive, you get the error 
message: CANT! ERROR: DISK I/O. 
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Changing the Slot Address 

To change the data diskette slot address, move the cursor to <MORE> 
and press RETURN to display the Main Storage Management menu 
extension and then to SLOT and press RETURN. 

It is only possible to change the slot address if there is more than one 
disk drive controller in the computer. If there is only one controller, the 
SLOT function has no effect. 

If there are other controllers, they must be in slots immediately adjacent 
to the boot slot (usually number 6). The SLOT function does not operate 
with configurations where there is a gap between controller slots such as 
6 and 4. With controllers in slots 5 and 6, the SLOT function changes the 
data diskette slot address to 5 if it is currently 6 and to 6 if it is currently 5. 

DISK ERRORS 

You should never get a disk error. But they sometimes happen. They 
are often caused by something you overlooked. You might change the 
disk drive and forget to put a diskette in the drive. You might leave the 
drive door open. You might put the wrong diskette-one that is not 
initialized for VisiPlot use-in the drive. A diskette might get damaged 
through mishandling, accident, or disk drive malfunction. 

In all of these cases, you will get the error message CAN'TI ERROR: DISK 
I/O. This message is accompanied by a beep. The message remains in the 
status area until you press any key. The function you requested is not 
performed. 

If you get the CAN'TI ERROR: DISK I/O message make sure: 
• The correct slot and drive numbers are set 
• The diskette is in the drive 
• The diskette has the correct side facing up 
• The drive door is closed completely 

Then try the operation again. If you still get the error message, try the 
diskette in a different drive if you have multiple drives. You might also try 
a different VisiPlot data diskette. Make sure you Use a diskette for which 
you have a backup. It is always a good idea to have backup of your 
diskettes; it is a necessity when you are having problems. 

If you continue to get the error, see the troubleshooting guide that 
carne with your computer and disk drives. 
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SAVING DATA 

After you enter new data or modify existing data with the Edit function, 
you will want to save the data on a diskette for use at a later time. The 
SAVE function provides the means of doing this. 

Move the cursor to SAVE and press RETURN. 

A different menu appears in the status area. The options are NORMAL 
and DIF. This menu lets you choose the format in which the data will be 
saved. If the data is to be used only with the VisiPlot program, you will 
want to save it in the NORMAL format. 

The DIF (for Data Interchange Format) option stores data in a format 
that can be used by other Personal Software programs, such as VisiCalc. 

With the cursor on NORMAL, press RETURN again. 

The menu area contains the directions < -, - >, SPACE BAR, OR 
RETURN. Below the status area the program displays a list of the series 
currently in memory. At the bottom of the list are the items (NONE) and 
(CALL). The series listed should be FLOPPY SALES and FLOPPY 
DENSITY, the ones you loaded from the SAMPLE 1 file. 
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You can cancel the SAVE operation by moving the cursor to (NONE) 
and pressing RETURN. 

To SAVE data, you have a few choices. You can move the cursor to 
(ALL) and press RETURN, which writes all the series currently in mem­
ory out to the data diskette. But if you only want to save a single series, 
you can move the cursor to the series name and press RETURN. Finally, 
you can save some of the series in memory by moving the cursor to the 
name of the first series to be saved and pressing the space bar. When you 
press the space bar, an asterisk (.) appears next to the series name. The 
asterisk means the series is selected to be saved when RETURN is pressed 
but it is not yet saved. 

You can change your mind up to the time you press RETURN. If you 
don't want to save that series after all, press the space bar again. The 
asterisk disappears. The series is no longer selected for saving. Pressing 
the space bar again selects the series again. You can select as many or as 
few series as you want in this manner. 

When you select series in this manner, they are all saved to the data 
diskette when you press RETURN, including the series to which the cursor 
is pointing whether or not it has an asterisk next to it. If the cursor is on 
(ALL) or (NONE), they have precedence regardless of the number of 
asterisks in the list. 

For the purpose of this lesson, move the cursor to (ALL) and press 
RETURN. The disk drive makes a whirling sound and the status area says 
READING DIRECTORY.. The directory of the files currently on the disk­
ette is listed under the status area. It is the same list you saw when you 
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LOADed SAMPLE 1. But there is a slight difference. In the LOAD list the 
last item was (NONE) and in this list it is (NEW FILE). 

You now have a choice and a responsibility. You must select the file to 
which the selected series are to be written. It is a responsibility because, if 
you select an existing file, the data in it is destroyed and the selected 
series are stored in it. You must be careful not to erase any data you 
want to keep. 

Usually, after you have created a new data series with the Edit function, 
you will want to put it in a new file. If you have updated information in an 
existing file, you will probably want to replace the old data with the new. 
Remember, the selected series replace all the data series in the file, not 
just those of the same name. For example, if you load a file that contains 
series A, B, and C, modify series B, and then save series B to the same file, 
the file will contain only series B because you did not save series A and C. 

Also remember that all selected series are saved in the same file regard­
less of which file they Were loaded from. 

It is good practice to save all data in new files. If after a period of time 
you find you don't need the old data, you can erase the old file with the 
DELETE function which is described later in this lesson. 

For now, select (NEW FILE) and press RETURN. 

When you choose to create a new file, the program prompts for a file 
name. Enter a name that is different from all other names on the diskette 
and press RETURN. You will get an error message if a file by that name 
already exists on the data diskette. 

If you have followed the directions, you just tried to write to the program 
diskette in drive 1 of the boot slot. And you got the error message, CAN'T! 
ERROR: WRITE PROTECTED. Your diskette is write protected: you cannot 
write on it. This protects the program diskette from being accidentally 
destroyed. Press any key except RESET to redisplay the menu. 

There was no need to save the series you selected because there is 
a;lready a copy of them in the file named SAMPLE 1. You didn't make 
any changes to them because you have not yet used the Edit function. 

Remember to check the data diskette drive assignment before starting 
a SAVE. The data diskette drive number cannot be changed after you 
start the SAVE. If you forget to change the drive number, cancel the SAVE. 
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You can cancel a SAVE function by selecting (NONE) when the list of 
series is displayed. If you go beyond that point before deciding to cancel, 
you can select (NEW FILE] from the list of files and enter a RETURN without 
a name when prompted for a file name. The lone RETURN is an invalid 
response that cancels the function. 

CREATING A DATA DISKETTE 

Before you can perform a successful SAVE, you must create a new data 
diskette. A data diskette is any diskette that is initialized by the VisiPlot 
INIT function or by the DOS 3.3 INIT (Initialize) command. See The DOS 
Manual for information on initializing diskettes with DOS 3.3. 

To use the VisiPlot INIT function, move the cursor to <MORE> and press 
RETURN. The remaining Storage Management functions are displayed. 
Move the cursor to I N IT and press RETURN. 

You are prompted to put the diskette to be initialized into the data disk­
ette drive. Put the diskette in the drive, close the door, and press RETURN. 
If the diskette is already initialized, you are given the opportunity to cancel 
the operation. The INIT function destroys all the data on the previously 
initialized diskette. 

If you try to intitialize the VisiPlot program diskette, the INIT function 
detects it and automatically cancels the operation without your interven­
tion. 

A diskette initialized with the INIT function has Apple DOS 3.3 on it but 
does not have a HELLO program, therefore, you cannot boot from a 
VisiPlot program initialized diskette. 

When the INIT function is complete, you are returned to the Main 
Storage Management menu, not to the extension menu from which you 
selected the INIT function. 

After you have created an intitialized diskette, you can repeat the pre­
ceding section on saving data and actually SAVE the data. If you have a 
two drive system, put the initialized data diskette in drive 2 and change 
the data diskette drive number with the DRIVE function. If you have a one 
drive system, remove the program diskette and put the data diskette in 
drive 1. The program diskette does not have to be in Drive 1 until you load 
the Plot program. When the program diskette is needed but not present, 
you are prompted to put it into Drive 1. 
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CLEARING SERIES FROM MEMORY 

When you SAVE data on a diskette, the copy of the data in the computer 
memory is not erased, it remains there. There are times when you will 
want to eliminate some or all of the series from memory to make room for 
other series. After you have saved new and modified series on diskette, 
you may want to load some others. You may have to make room for the 
new data you want to load. 

The CLEAR function erases some or all of the series from memory. Move 
the cursor to CLEAR and press RETURN. The menu is replaced with the 
direction SELECT SERIES TO CLEAR. It is important to remember that you 
must select the series you want to erase, not the ones you want to keep. 

Again, a list of the series in memory is displayed under the status area. 
Along with the series names there are two extra options: (KEEP ALL) and 
(KEEP NONE). The former erases nothing from memory, in effect, it cancels 
the CLEAR function. The latter erases everything from memory. 

You can erase a single series by moving the cursor to it and pressing 
RETURN. You can erase two or more series by moving the cursor to the 
name and pressing the space bar. Just like the SAVE function, the series 
name is marked with an asterisk (*) indicating the series is to be erased. 
Pressing the space bar again eliminates the asterisk. You can mark as 
many series with an asterisk as you wish before pressing RETURN. 
Remember, the series to which the cursor is pointing is also erased when 
you press RETURN whether it has an asterisk or not. You should leave the 
cursor on the last series to be erased. 

You are going to clear the series FLOPPY SALES from memory. 
Remember, this has no effect on the copy of the series that is on diskette 
in the file SAMPLE 1. Move the cursor to FLOPPY SALES and press 
RETURN. 

After you press RETURN, the program displays a list of the remaining 
series in memory, just as it does for the LOAD and LOOKUP functions. You 
can CONTINUE which returns to the Main Storage Management menu or 
PRINT the list and then return to the Main Storage Management menu. 

CALWNGTHE PLOT PROGRAM 

When you are done LOADing and EDITing data, you normally want to 
go to the Plot program. The - > PLOT option calls the Plot program 
from the program diskette and reads it into memory, overlaying the Stor­
age Management program. 
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You have already seen what happens when you call the Plot program. 
You used this function in Lesson One. 

In this lesson we will review the procedure. 

Move the cursor to - > PLOT and press RETURN. 

The menu disappears and you are given a chance to change your mind. 
You are prompted to press the Y key to verify that you do in fact want to 
leave the Storage Management program and load the Plot program. If 
you press any key except Y, the request is cancelled and the Main Storage 
Management menu is redisplayed. Press the Y key and the process of 
loading the Plot program begins. 

If you have not LOADed data into memory or created new data series 
with the EDIT functions, you will get an error message that says NO 
ACTIVE SERIES. You cannot get into the Plot program unless you have 
some data to plot. If you get the message, use LOAD to select the series you 
want. 

When the Plot program is loaded, the Select menu is displayed. Move 
the cursor to NONE and press RETURN, which displays the Main Plot 
menu. Move the cursor to ->MAIN and press RETURN. Now the process 
begins in reverse. You are prompted to verify that you want to leave the 
Plot program and return to the Storage Management program. Press the 
Y key and after the loading process is completed, the initial Storage 
Management menu is again displayed. 

Keeping Data When Changing Programs 

When you call the Plot program, you must have one or more series in 
memory. This data is preserved in memory when you change programs. 

To see for yourself that the data is kept, move the cursor to LOOKUP. 
Look at the list and remember what is on it. Now load the Plot program 
and select any chart type from the Select menu. Compare the list of series 
with the list from the LOOKUP function. They are identical. No data was 
lost in the transition. 

Now go back to the Storage Management program. Do a LOOKUP 
again and you will find that the list has not changed. 
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DELETING FILES FROM THE DATA DISKETTE 

As you create new data series and modify old ones, your data diskettes 
will fill up. Some of the data will be old series that contain out of date 
information and some will be series for which you no longer have any 
need. 

For this part of the lesson, make sure the data diskette you created with 
the INIT function is in your data diskette drive. This is drive 2 if you have 
multiple drive system and drive 1 if you have a single drive system. 

Also make sure that the correct slot and drive are listed in the bottom 
line of the status area. 

The DELETE function erases these files from your data diskettes. This 
function is on the Main Storage Management menu extension. Move the 
cursor to <MORE> and press RETURN. When the menu extension is 
displayed, move the cursor to DELETE and press RETURN. 

The READING DIRECTORY ... message is displayed in the status area as 
the data diskette drive begins running. The list of files on the diskette are 
listed below the status area. Select a file for deletion in the same manner 
that you selected a file for loading or saving. Move the cursor to the file 
name and press RETURN. Because this function permanently erases files, 
you are prompted to verify that you did, in fact, intend to erase a file. You 
must press the Y key to continue the DELETE function. If you press any 
other key, the function is cancelled. 

You will get an error message if the data diskette is write protected. 

RETURNING TO THE MAIN STORAGE 
MANAGEMENT MENU 

When you go to the extension menu, the functions you have used so far, 
return you to the Main Storage Management menu. If you call the exten­
sion menu and decide not to perform any of the available functions, you 
can return to the Main Storage Management menu by selecting the 
MAIN option. This option simply returns you to the Main Storage 
Management menu. 
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GETTING OUT OF THE VISIPLOT PROGRAM 

There is one remaining option in the extension menu that has not been 
mentioned, QUIT. This option exits the VisiPlot program and returns con­
trol to Applesoft Basic; the] prompt is displayed. You must load the Visi­
Plot program again if you want to do more VisiPlot work. 

LOADING VISICALC DATA 

This section describes how to move data between the VisiCalc program 
and the VisiPlot program. If you do not use both of these products or have 
no need to transfer data, you should skip this section and go to the section 
"In Summary~' 

You can load and plot VisiCalc data with the VisiPlot facilities. The 
VisiCalc data must be saved in a DIF file. This means that interchange 
between the two products is only possible if you have a copy of the 
VisiCalc program higher than version number 1.37. 

You must save the VisiCalc data that is to be plotted with the /S# 
command. The stored data should be a sequence of data values that are 
meaningful to plot. For example, the data items in a single row or column 
is usually related to each other. 

You can use rows or columns of VisiCalc data in VisiPlot charts. Single 
or multiple rows and columns can be used. Each row or column is treated 
as an individual data series. Rows of data use the label, if there is one, in 
the first (left most) field as the series name. Columns use the top field as 
the series name. If the first field in either form is not a label, the VisiPlot 
program creates a name for each series in the sequence SERlE SO, 
SERIESl, etc. Label fields occurring later in the sequence are converted 
to o. 

Data from the VisiCalc program, while in a format acceptable to the 
VisiPlot program, does not contain all the information the Storage Man­
agement program expects. It does not contain a period or a start date. 
When you load VisiCalc data, you are prompted for the missing items. 

The following exercise loads data from the personal budget example 
in Lesson Three of the Apple II and the Apple II Plus VisiCalc manual. If 
you did the exercise in this lesson, you stored the final sheet on diskette 
under the name PERSONAL BUDGET. Follow these instructions to 
create a DIF file of the UTILITIES data in the budget sheet. 
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1. Move the cursor to A6, the UTILITIES label. Row labels, when 
included in the DIF file, become series names in the VisiPlot program. 
If the label spans the VisiCalc columns, only the first column is used, 
the second column is treated as a zero value. The cursor location 
marks the upper left corner of the rectangle of data to be saved. The 
lower right corner is specified later. 

2. Enter the /S# command to save the data in the DIF format. 
3. Specify SAVE (S). 
4. Save the data under the name UTIL.DIF. It is advisable to use suffixes 

such as DIF, VC, and VP to distinguish the format in which different 
files are stored. 

5. Specify a lower right corner of M6. 
6. Enter an R to specify that the data be saved in rows rather than 

columns. 

Load the VisiPlot Storage Management program. Place the VisiCalc 
data diskette in the VisiPlot data diskette drive. Select the LOAD function. 

The file is loaded in the normal manner, just as VisiPlot data files are 
loaded. One of the files is named UTIL.DIF. Move the cursor to this file 
and press RETURN. 

The loading of the file begins. In a few moments, the disk drive stops 
and the program prompts for a period for the data series. Enter 12 
because the data in this file is on a monthly basis. Next you are prompted 
for a major start date (year). Enter 1980. Finally, you are prompted for a 
minor start date (period). Enter 1 for January. The disk drive begins 
again and the loading of the data is completed. 
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When the LOAD is completed, the program displays the list of series in 
memory. The file contained a single data series named UTILITIES. The 
series name is taken from the label in the VisiCalc row. If you had not 
saved the label along with the data, the VisiPlot program would have 
created a name for the series. 

You can go to the Plot program and create a chart of the UTILITIES 
data from your VisiCalc worksheet. You can also modify the data with the 
VisiPlot Edit functions (described in Lesson 3). 

After modifying the data with the Edit functions, you can return to the 
VisiCalc program and put the data back into the worksheet. Note, how­
ever, that data saved in DIF does not contain the formulas, if any, in the 
worksheet. The row you used in the preceding exercise did not contain 
formulas, it contained only values. You can load this data and overlay 
the VisiCalc worksheet with no effect on the function of the sheet. 

The VisiPlot series name is not put back into the VisiCalc file as a row 
label. You must read the data into the value fields, not the label fields. 
Because the series name is not used, the VisiCalc label will be destroyed. 

Formulas are not stored with data written to a DIF file. Therefore, no 
formulas are put into the worksheet when a DIF file is loaded with the /S# 
command. If you do this, the worksheet will look correct and values that 
depend on the new data will be correct. But changes to other values in the 
worksheet will not affect the newly loaded DIF data, because there are no 
formulas. 

The last point is important enough to repeat. The /S# command does 
not load or save VisiCalc formulas, only data values. 

If you wish to create your own DIF files for use with the VisiPlot pro­
gram, see the Programmer's Guide to the Data Interchange Format, 
document number SATN-18. 
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IN SUMMARY 

This completes the Storage Management lesson except for the EDIT 
function which is described in Lesson Three. You have used all the other 
Storage Management functions. You might want to go back to the LOAD 
function and look at some of the other files on the program diskette. 

If you have any trouble with a function, look it up in the reference sec­
tion or return to the part of the lesson in which it was described. 

The next lesson covers the use of the EDIT function which lets you create 
and modify data series. 
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LESSON THREE 

USING THE EDIT FUNCTION 

The VisiPlot Edit function has two major purposes: 
• Creating new data series 
• Modifying existing data series 

After loading the VisiPlot program, select the EDIT function from the 
Main Storage Management menu by moving the cursor to EDIT and press­
ing RETURN. There is no need to LOAD a file, this lesson is devoted to 
creating a new data series. If you already have some data series in 
memory, you can leave them there. However, if memory is fuli, that is, 
if it has 16 series in it or 645 data points, you will have to CLEAR some of 
them before continuing with this lesson. The lesson assumes that there are 
no series loaded from this point. 

USING EDIT 

After selecting the EDIT function, you are prompted to select a series 
from the displayed list. The message in the status area, which you have 
seen before, says you can use the arrow, space bar, and RETURN keys. 
You did not LOAD a file, so there are no series names in the list, only 
(NEW SERIES) and (NONE). 

(NONE), as it does with other functions, returns you to the Main menu. 

2-53 



VISIPLOT™ ~t~~i APPLE II 
LESSON THREE TUTORIAL 

In this lesson you are going to enter the data for a series called FIRST. 
Move the cursor to (NEW SERIES) and press RETURN. The status area 
changes to the data entry configuration and prompts for a series name. 

Type FIRST and then press RETURN. Remember, you can correct 
typing mistakes with the ESC key. The ESC key backs over the last char­
acter and erases it. 

Next the program prompts for the period of the new series. The prompt 
lists the current period that is being used by the program. If you have 
not done any editing or working with series up to now in this session, the 
period will be 1. After you have worked with a file, the period from that 
file is used. For example, if you had just finished working with a file that 
had a period of 4, the current period would be 4. 

F or now select a period of 1 by typing 1 and then pressing RETURN. 

Next you are prompted for the starting year of the new series. Enter 
1966 and press RETURN. If the period had been other than I, you would 
also be prompted for the starting period. A series can begin at any period 
in its starting year. 

If you had not entered a date and had only pressed RETURN, the date 
o would be used. The program makes a choice if it can when you do not 
enter anything. When it cannot make a choice, it cancels the function or 
continues to ask for data, whichever is appropriate. 

Finally, you are prompted for the first value in the new series. Now the 
bottom line of the status area contains DATE and FIRST, as column headers. 
There is a cursor in the column headed by the series name. 

The first value for the series is 23. Enter 23 at the keyboard and press 
RETURN. Note that the value appears in the third line of the status area 
until RETURN is pressed. In this location, you can correct it with the ESC 
key. When you have it correct and press RETURN the value moves into 
the cursor location under FIRST. The starting date appears opposite the 
value in the DATE column. 
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The status area changes, it now reads USE < ESC> FOR COMMANDS. 
This completes the initial sequence when entering a new series. If you 
had selected an existing series, you would have come immediately to 
this point in the program. The only difference being that a series, or the 
first 20 data points of the series, would be displayed on the screen. 

At this point you can add more values to the end of the series or call the 
Edit command menu. For now you should add some more values to the 
series named FIRST. After the series is complete you can use the Edit 
commands on it. 

Adding Vol ues to the Series 

To add a value for the year 1967, press the right arrow key. The date 
1967 appears under 1966 and the cursor moves down one line. Type 28. 
Again the value appears on the third line of the status area. Press RETURN 
and the value appears in the cursor next to 1967. 

Gaps are not allowed in the date sequence. The program automatically 
adds 1 to the date for each new entry. If the period is 1, the year is incre­
mented by 1. If the period is other than 1, the period is incremented and 
the year is incremented when the period Q"oes full cycle. 

To add the next few values, repeat the preceding process. Press the 
right arrow key, enter the date, and press RETURN. Enter the values 33, 
37 and 41. Note that a solid bar separating the dates from the values 
appears after you make a couple of entries. 
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There is a shortcut method for entering new data. Press the right arrow 
key again to show the date 1971 and enter 44 but do not press RETURN. 
Instead, press the right arrow key again. The value, 44, moves to the 
correct place and the cursor moves down a line to the next date. 

Add the remaining values in this manner. Press the right arrow key 
and enter the value. Add 44, 53, 61, 75, 64, 73, 82, and 79 to the series. 

After the last value, the cursor is below the list with the date 1980. We 
don't have a value for 1980, so press the left arrow key. The cursor moves 
back up to the 1979 value and the 1980 date disappears. 

Replacing A Value 

You can move the cursor up and down the list with the arrow keys. In 
this list the cursor does not wrap around. A little later you will use a rapid 
means of moving the cursor in a large series. 

You can replace a value simply by moving the cursor to the value that 
is to be replaced and entering the new value. The current value at the 
cursor location is replaced by the new value when you press the RETURN 
or arrow key. 

Move the cursor to the year 1969 which has a value of 37. This value 
should have been 36.9. Type 36.9 and press the RETURN or either arrow 
key. The old value is replaced. 
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THE EDITOR COMMANDS 

You have been working at the data entry level of the Edit function. To 
leave this level and go to the command level, press the ESC key. The Edit 
command menu appears. 

The Edit command menu provides many functions. With it you can: 
• JUMP to a specific year (and period) within the series 
• INSERT new data points between existing data points 
• DELETE existing data points 
• FORMAT the manner in which data is displayed 
• PRINT the contents of a series 
• UNDO (erase) all changes made to a series 
• FILL areas of a series with values generated by predefined algorithms 
• EXIT to the Storage Management Main menu and save the work you 

have done 
• Change the specifications (SPECS) of a series 
• Return to the entry level (EDIT) 

Leaving the Edit Function 

The EXIT option returns to the Main Storage Management menu. When 
you exit by this route, the work you created or modified is saved. Move the 
cursor to EXIT and press RETURN. The Main menu replaces the Edit com­
mand menu and the listing of the series is erased. 
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To see that you have created a series, select LOOKUP. The list shows 
that there is a series named FIRST with a period of 1. It begins in 1966, 
ends in 1979, and has 14 data points. Press RETURN to continue. 

Returning to the Edit Function 

Select EDIT again. This time there are three items in the series list, the 
same entries you saw earlier plus the series you created. Select the new 
series, FIRST, and press RETURN. 

This time you don't have to enter a name, period, or starting date. The 
contents of the series are listed. The status area contains the USE <ESC> 
FOR COMMANDS message. 

Using the Edit Commands 

The following sections show the use of the Edit commands. For each 
section you will begin in the entry level. The entry level is that part of the 
function in which you can input initial data to the series. While you are in 
the entry level, the status area contains the message USE <ESC> FOR 
COMMANDS. To begin each section, press the ESC key and then move 
the cursor to the subject function. 

In the following section describing the JUMP command, press ESC and 
then press RETURN. The cursor is located at JUMP when you enter the 
command menu. 
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Jump-Moving from Point to Point 

The JUMP command lets you move from date to date in the series without 
repeatedly pressing the arrow keys. Move the cursor to JUMP and press 
RETURN. 

The prompt says < -- TOP, - > BOnOM, YEAR. If you enter a date, the 
cursor moves to that date. If the series has a period other than 1, you are 
prompted for the period also. If the date is currently displayed, the cursor 
simply jumps to that position. If it is not displayed, the screen is erased 
and is rewritten with the specified date at the bottom of the screen and the 
cursor on it. 

If the date does not exist in the series, there is a beep and the date is not 
accepted. At this point, you should enter a valid date. 

Pressing the right arrow key moves the cursor to the last entry in the 
series. The left arrow key jumps to the first entry in the series. 

After the jump is completed, you are returned to the EDIT function entry 
level. 

To exit the JUMP function without making a move, press the RETURN 
key twice. 

Insert-Adding An Entry 

The INSERT command lets you add a new values at the current cursor 
location in the series. Insertion with this command works just like adding 
a value except that it operates anywhere in the series, not just at the end. 
The command opens up the series at the cursor location. All values at and 
below the cursor are pushed ahead to the next date. 

Type the new data and press RETURN if you are inserting a single 
value. If you have more than one value to insert, type the new data and 
press right arrow key. Press RETURN after the last entry. You can correct 
errors with the ESC key before pressing the RETURN key or the right 
arrow key. Pressing the RETURN key returns you to the entry level. 

Delete-Erasing a Data Point 

The DELETE command erases one or more values beginning with the 
current cursor location. The range to be deleted is listed in the status 
area. You can abort the DELETE command by pressing the ESC key. 

When you select the DELETE command, only one data point, the one at 
the cursor, is listed for deletion. Moving the cursor, in either direction, 
broadens the range of values to be removed from the series. As you move 

2-59 



VISIPLOTTM ~U~l APPLE II 
LESSON THREE TUTORIAL 

the cursor, the range listed in the status area changes. If you move the 
cursor beyond the end of the series, the DELETE command is cancelled. 

You can DELETE in either direction from the original cursor position. 
However, the initial cursor location'will always be the beginning or end of 
the range to be erased. 

Pressing RETURN when you have defined the correct range removes 
the selected values from the series. The values below the removed area 
move up to fill the new empty dates. 

You are returned to the entry level. 

To exit the DELETE command without making a change to the series, 
press the ESC key. 

Specs-Changing the Series Specifications 

The SPECS command provides the means of changing the name, period, 
or start date of the series. This command displays a new menu. Selecting 
the menu displays prompts for new data to replace the current series 
name, start date, or period. 

When you change a series specification, the change takes place imme­
diately and is shown on the screen. If you change the name, the new 
name replaces the old name as the value column header. A new period or 
starting date causes the date and/or period columns to be changed on the 
screen. The existing data points do not change, only their date and/or 
period. 
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You can respond to the prompts for data by pressing the RETURN key 
without entering data. When you do this, the program assumes values. 
For the NAME function, it generates the name SERIESn, where n is a 
number from 0 through 15. For the PER function, it uses the current 
period. For the START function it uses the date O. 

Format-Changing the Data Display 

The FORMAT command lets you specify how the data values in the series 
are to be displayed. You can select the fixed format and specify the 
precision (number of decimal places from 0 to 6) and column width (total 
number of digits displayed from 6 to 15). You can also specify that values 
be displayed in the floating format. 

The function first prompts for a precision (0 to 6) or the floating point 
format (-1). Pressing RETURN retains the current format and precision. 
Next it prompts for the column width which can be from 6 to 15 digits wide. 
Pressing RETURN retains the current column width. 

If the values are displayed as a series of greater than symbols 
(»»»), either: 
• The value is too large for the column width. If this is the case, increase 

the column width. 
• The value is an exponential number (such as lE-03) and you are in a 

fixed format. You cannot enter values in the exponential format but 
values less than .001 and greater than 9 digits to the left of the decimal 
point are automatically converted to the exponential format. 

If you do not choose a display format, the floating format is used. 

The FORMAT command does not affect how the values are stored, only 
how they are displayed in the EDIT function. The format remains in effect 
until changed or until you exit the EDIT function. 

Print-Listing a Series 

The PRINT command lets you print a copy of the current screen content 
on your printer. You are prompted for the slot number to which the printer 
is attached the first time you use the PRINT command during a session. The 
program remembers the specified slot number. 

The command prints the contents of the current screen without the bold 
bars and without any blank lines at the bottom of the screen. 

PRINT lists the contents of the currently displayed screen and then 
returns you to the entry level. 
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You can stop a printing operation by pressing CTRL-C. 

Undo-Remove All Changes 

The UNDO command cancels all the changes made to the series since 
you selected the EDIT function. If you UNDO a newly created series, it is 
completely erased. 

Keep in mind that the UNDO command removes all changes made 
since selecting the series, not just the last change. 

Edit-Returning to the Entry Level 

The EDIT command takes you back to the entry level of the EDIT function 
without executing any of the commands. 

Fill-Adding to A Series 

The FILL command provides a means of inserting values into the middle 
of a series and interpolating missing values. You can insert values in an 
arithmetic or geometric progression from the value at the current cursor 
location. You can also select a whole series and insert it into the series 
being edited. You can fill in missing values in a series, interpolating 
between two known values. 

The FILL command displays its own menu. 
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The ARITH and GEOMET functions both operate in the same manner. 
They prompt for a number of values to be inserted. The number can be 
any value that, when added to the existing points in the series, does not 
exceed the maximum of 150 points in a series or the 645 points in memory. 
Next the function prompts for a factor to be used in the calculation of the 
new values. In the ARITH function, the factor is added to the current 
cursor value and each generated value until the specified number of 
values have been generated. In the GEOMET function, each successive 
value is multiplied by the factor. 

The INSERT function displays the current list of series in memory. You 
can select one. It is inserted, in its entirety, into the current series at the 
cursor location. If you insert a series into itself, the inserted values are 
those that existed before entering the EDIT function. 

The INTERP function performs a linear interpolation of values beginning 
at the current cursor location and continuing to the first non-zero value. 
This function fills in missing data values. The missing values must be 
entered as zeros. There can be one or more missing values. 

If the value at the cursor is not zero, an error message is displayed and 
the function is canceled. If the value is zero, the function looks at the 
preceding period for a starting point and the next non-zero point for an 
ending value. It then linearly interpolates all points in between. 

Point the cursor to the first zero value in the sequence before invoking 
the function. 

The EXIT command returns to the entry level without performing a FILL 
command. 

SOME EXERCISES WITH THE EDITOR COMMANDS 

The following exercises give you some practice using the commonly 
used Edit functions. To do these exercises you must LOAD the file 
SAMPLE 2 from the VisiPlot program diskette. 

EXIT to the Main Storage Management menu, CLEAR memory, and 
LOAD the file named SAMPLE 2 which contains a series with the same 
name. You used the CLEAR function in the last lesson. It prompts you to 
decide what to keep and what to clear. This time, erase everything in 
memory by selecting the (KEEP NONE) option. Now select LOAD and 
SAMPLE 2 from the directory listing. 
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Large Series Displays 

Select EDIT and then select the series Sample 2. This series has 133 data 
points and a period of 12 (monthly) .. Its start date is 1977 I, the first period 
of 1977 or January 1977. 

The screen fills with numbers when you select the series. The date is in 
the left margin of the screen. For each date there are 12 periods; for each 
period there is a value. The dotes are to the left of the vertical bar. The 
period is the first number to the right of the vertical bar. The value is to the 
right of the period. 

Moving the Cursor and Scrolling the Screen 

SAMPLE 2 contains 133 data .points but the screen can only display 
20 of them at a time. To see the values beyond the first 20, move the cursor 
to the bottom of the screen with the right arrow key. Continue pressing 
the key when the cursor reaches the bottom. New dates and values 
appear at the bottom and old ones disappear off the top. This is scrolling; 
it is one means of moving to any point in the series. 

Press the left arrow key until you reach the top of the screen. Continue 
pressing the key. New values appear at the top and others disappear off 
the bottom. If you keep pressing the key until you reach the top of the 
series, there is a beep indicating that you can't go any further. 

Moving With the Jump Command 

If you wanted to add more values to the end of this series, you would 
have to press the right arrow key 133 times to reach the end. You can save 
time and effort by using the JUMP command. Press ESC to display the 
Edit command menu. Press RETURN with the cursor on JUMP. 

The JUMP prompt says that you can enter a date or press one of the 
arrow keys. If you specify a date, the portion of the series containing that 
date is displayed. 

Enter 1981 and press RETURN. You are asked for the period because 
this series has a period other than 1. Enter 1 and press RETURN. The data 
on the screen is erased and new data appears. The cursor appears at the 
bottom of the screen on the first period of 1981. If you specified the same 
date and period from a point below it in the series, the target date would 
appear at the top of the screen. The location of the target depends on the 
direction the cursor must move. 

2-64 



APPLE II 
TUTORIAL LESSON THREE 

You can also use the arrow keys with the JUMP command. Press ESC 
again. Select JUMP. The right arrow key moves to the bottom of the series 
and the left arrow key to the top. Press the right arrow key. The display 
changes; the new display shows the end of the series. 

Formatting the Data 

The values in this series are displayed with different numbers of decimal 
places, to different precisions. This is the floating point data format. This 
format gives a cluttered appearance to the screen and, at times, makes 
the values difficult to read. 

With the help of the FORMAT command you can display the values in a 
manner that is neater and more readable. 

Go to the Edit command menu and select FORMAT. The top line of the 
status area indicates that the data is currently in the floating format. The 
second line tells you to enter a value of 0 through 6 to set a fixed precision. 
The number indicates the number of decimal places to which each num­
ber is to be displayed. It also says that you can enter -1 to specify floating 
format, which is the format in which the data is currently displayed. The 
last item in the prompt says to press RETURN alone to cancel the function. 

Enter the number 2 to specify the fixed point format with two places of 
precision. Press RETURN. You are prompted for the column width. The 
width is the total number of digits that can be displayed in the column 
including the decimal point. This can range from 6 through 15. If you press 
RETURN without entering a value, the current column width is kept. For 
now, just press RETURN. 

The series on the screen is redisplayed with the decimal points lined up 
and two digits to the right of the decimal point. 

Printing the Data on the Screen 

If you have a printer attached to your computer, you can print the 
contents of the current screen. Press ESC and select the PRINT function. 
If you have not yet used the printer since loading the VisiPlot program 
the program prompts for the slot number to which it is attached. If the 
printer is connected to slot I, enter the number 1 and press RETURN. 

The printer begins printing the screen contents. You can let the whole 
screenful print or can stop it by pressing CTRL-C. 
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Inserting Data Into the Middle of a Series 

Display the beginning of the series and move the cursor to the first 
period of 1978. Press ESC and select the INSERT command. 

Note that the value that was in this location has moved down one place 
in the series. Also, the values that followed the value have each moved 
down one place. The dates did not change, however, one new period 
was added to the end of the series. 

You can now insert a new value at this point in the series. Type 999 
and press RETURN. The value 999 is inserted into the 1978 period 110ca­
tion. 

To insert multiple values, press the right arrow key after typing the 
value. The value is placed in the current open space and a new space is 
opened following the new value. To terminate the insertion, press 
RETURN. Press ESC, select INSERT again and enter two more values of 
999 using the right arrow key. After you enter the second value, press 
RETURN. 

After RETURN is pressed, the editor returns to the entry level. 

Deleting Data from A Series 

If you decide you don't want the three 999 values in the series, you can 
delete them with the DELETE command. 

Move the cursor to the first 999 and call the Edit command menu by 
pressing the ESC key. Select DELETE. The status area says you are currently 
set to delete from 1978 1 to 1978 I, or one point in the series. The status area 
also says that you can press the ESC key to abort the deletion. 

Press the right arrow key several times and watch the status area each 
time you press the key. The TO date changes as the cursor moves from 
value to value. Move the cursor back to the third 999 value at 19783. Press 
RETURN. The display is erased and rewritten. The three 999 values are 
removed and the series is back to its original conditions. 

CONTINUING WITH THE EDIT FUNCTIONS 

The remaining Edit functions should be easy to use with the experience 
you now have. If you have any problems with any of them, look them up 
in the reference section. 
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LESSON FOUR 

MORE ABOUT PLOTTING 

This lesson is a series of step by step examples showing how to make 
different kinds of VisiPlot charts. The data series that are used in these 
examples are stored on the VisiPlot program diskette under the names 
GEM PRICES, PRESPREF, and MATH FUNCTIONS. 

The GEM PRICES file contains series of the prices of 1 and 2 carat 
rubies for the years 197 4 through 1980, the price of 3 carat sapphires over 
the same period, the price of a 1 carat investment quality diamonds for the 
years 1967 through 1978, and the Consumer Price Index for the years 
1967 through 1978. 

The PRESPREF file contains series of political poll data taken at random 
times during a mythical election campaign. 

The MATH FUNCTIONS file contains two series of values for two math 
functions. 

This lesson assumes you have read and used the functions described 
in Lesson One and Lesson Two covering the Plot and Storage Manage­
ment programs. 

GETTING STARTED 

Load the VisiPlot program and then LOAD the GEM PRICES, PRES­
PREF, and MATH FUNCTIONS files from the program diskette. Call the 
Plot program. If you have trouble with any of these operations, review 
Lesson Two. 

This lesson shows how to generate many different charts and how to 
combine charts. The sections begin with a picture of the chart that is to be 
generated. The picture is followed by a list of the keys you must press to 
generate the chart. A key name preceded by a word or phrase enclosed 
within parenthesis indicates a cursor position you must move to before 
pressing the indicated key. A word or phrase in quotation marks preceded 
by the word Enter indicates that the word or phrase must be typed. For 
example: 
• SP ACE BAR -means press the space bar 
• RETURN -means press the RETURN key 
• (LINE) RETURN-means move the cursor to LINE and press the 

RETURN key 
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• Enter "PERCENT OR TOTAL" RETURN-means enter the phrase 
at the keyboard and press the RETURN key 

SINGLE LINE CHART 

Beginning in the Select menu: 

(LINE) RETURN 

(1C RUBY) RETURN 

(PLOT) RETURN 

There is nothing new in this chart except the data. You generated 
several single line charts like this one in Lesson One. 
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TWO LINE CHART 

(NEW) RETURN 

(LINE) RETURN 

( 1 C RUBY) SPACE BAR 

(3C SAPPHIRE) RETURN 

(PLOT) RETURN 

LESSON FOUR 

There are a couple of new things in this chart. First the chart contains 
two lines instead of one. The two lines are plotted with different symbols­
the square box which you saw in Lesson One and a diamond shaped sym­
bol. The legend at the bottom of the chart lists both series and shows what 
plotting symbol was used for each. The bottom line of the status area lists 
the last series selected and now contains an ellipsis following the type of 
chart. The Ellipsis indicates that multiple series were selected. 

Note that both series were selected before the plot was drawn. 
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THREE LINE CHART 

(NEW) RETURN 

(LINE) RETURN 

(1 C RUBY) SPACE BAR 

(3C RUBY) SPACE BAR 

(3C SAPPHIRE) RETURN 

(PLOT) RETURN 

APPLE II 
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The new feature of this chart is the use of the pound sign (#) as the plot­
ting symbol of the third series. Note that the Y-axis scale has a factor of 
10E3 (or 1000) at the top, indicating that Y-axis labels must be multiplied 
by 1000. 

This chart is difficult to read. The information for the years 1974 through 
1979 is crammed together in a small space. The only thing that shows up 
well is the 1980 price of 2 carat rubies. This chart may be satisfactory if its 
purpose is to show what happened to the price of 2 carat rubies in 1980. 
However, if the other information is equally important, it might be a good 
idea to change the range to 197 4 through 1979 and handle the 1980, 2 
carat ruby price in some other manner. 
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Another approach is to change the scale to show the earlier data clearly 
and let 1980, 2 carat ruby price go off the chart and show its value with a 
moveable title. This is the approach used in the following photograph. 

SINGLE BAR CHART 

(NEW) RETURN 

(BAR) RETURN 
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(NORMAL) RETURN 

(1 C RUBY) RETURN 

(PLOT) RETURN 

APPLE II 
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Again, this chart is no different than the bar charts you did in Lesson 
One. It can be made different by selecting half-width bars. Repeat the 
sequence and select LEFT instead of NORMAL when the Bar menu is dis­
played. 

The only differences in the chart are the width of the bars and the bottom 
line of the status area which says BAR-LEFT where it said BAR on the chart 
with full-width bars. 

The half-width bars are used for comparative charts as shown in the 
next example. 
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COMPARATNEBARCHART 

(NEW) RETURN 

(BAR) RETURN 

(LEFT) RETURN 

(1 C RUBY) RETURN 

(PLOT) RETURN 

(SELECT) RETURN 

(BAR) RETURN 

(RIGHT) RETURN 

(3C SAPPHIRE) RETURN 

(OPTIONS) RETURN 

(COLOR) RETURN 

(GREEN) RETURN 

(OVERLAY) RETURN 
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There are many differences in the appearance of this chart and in the 
making of it. First, instead of choosing both series and plotting them as 
was done with multiple line charts, you selected each series on a separate 
pass through the Select menu. If you had chosen the two series at the 
same time (as you did for the two line chart), you would get a different 
chart. When the series are chosen on the same pass through the Select 
menu, the chart shows the series stacked on top of each other as shown in 
the following photograph. 

Generating the chart in this way, the two values are added. You sill use 
this style of bar chart when you are interested in the sum of the two series. 

To add the second series to the first chart, you used the OVERLA V 
function rather then the PLOT function. OVERLA V draws the new chart on 
top of the existing chart. It uses the same range and scale as the existing 
chart. 

You also changed the color of the second set of bars. If you had not, 
both sets of bars would have been the same color and wouldn't have shown 
up as clearly. Instead of changing the color you could have changed the 
format of the second bars to outlined or shaded. 

Overlaying a chart does not put a legend at the bottom. You must add 
that yourself with the TITLE options. You should put in the names of both 
series and specify which is which as shown in the following picture. 
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Note that the horizontal grid lines make the values at the right side of 
the chart easier to read. 

You may see a slight overlay between the bars in a comparative bar 
chart. You may also see a slight offset between the upper and lower bars 
of a stacked bar chart. Both of these conditions are caused by the Apple 
II color techniques. 

THE PIE CHART DATA 

In the .following sections you are going to draw pie charts. The data is 
from the file named PRESPREF that you loaded at the beginning of this 
lesson. The charts use four series, the ones named BROWN, GREEN, 
WHITE, and UNDECIDED. Each series has two data points. The first data 
point in each series represents the percent preference for each candidate 
in a 2-way Brown-Green race (the White value is 0). The second data 
point in each series represents the percent preference in a 3-way race of 
all candidates. 

The data used in pie charts does not have to represent a time series. The 
value of the zero data point represents one set of circumstances and the 
value of the 1st data point represents another. In this case the dates 
represent data items that are not necessarily related by time. 

A pie chart shows a single point in time and not a comparison of differ­
ent points in time as our other charts have. The VisiPlot program requires 
that the different values used in pie charts be from different series. All the 
values must be at the same date or reference number. The plotting fails 
if any of the series do not have the specified date. 
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A PIE CHART 

(NEW) RETURN 

(PIE) RETURN 

(BROWN) SPACE BAR 

(GREEN) SPACE BAR 

(UNDECIDED) RETURN 

Enter "0" RETURN 

APPLE II 
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Note that the WHITE series was not included. It wasn't needed because 
point 0 has a value of o. If you had included the WHITE series, it would 
have been listed in the legend with a 0 percentage and would not have 
a segment of the pie. 

Each segment of the pie is labeled with a letter. The letter refers to the 
items in the legend. This order of the series around the pie and in the 
legend is significant, it is the order in which you selected them. If you 
ha.d selected them in the opposite order, they would be listed in the 
opposite order and would have different relative positions on the pie. The 
first series always begins at the 3 o'clock position and extends in a clock­
wise direction. 

The bottom line of the legend contains a zero. This is the date or refer­
ence number of the selected data. 
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Shading and Titling A Pie Chart 

The generation of a pie chart follows a fixed series of events. After 
drawing the chart you are sent directly to the Title menu. Following the 
Title menu, you are given a chance to shade the chart. Then you have 
another chance at the Title menu. There are two phases at the Title menu 
because it is possible to cover a title with shading. When you exit the 
Title menu the second time, you have finished. There is no way back to 
the Title or shading functions. If you made a mistake, you must start over 
from the beginning. 

When the chart is finished, you have a screen with the picture and 
legend. Press RETURN and the Title menu appears. For now, select 
EXIT and proceed to the Shading function . 

. The Shading function asks you to enter a letter or RETURN. It is asking 
for a letter indicating a segment of the pie. You can specify the labels in 
any order; you can skip any you don't want shaded. If you change your 
mind, you can change the color of a segment you have already shaded. 

Enter A and press RETURN. The Color menu is displayed. If you have 
a color display unit, you can choose any color. If you have a black and 
white display unit, you should limit your selections to black, white, and 
one other color. All other colors look the same in black and white. For 
now, select WHITE1 and press RETURN. Segment A is filled in. 

You are asked for another letter. Enter B and press RETURN. This time 
select GREEN and press RETURN. The B segment is filled in. Leave the C 
segment as it is-black. Press RETURN. You are asked to confirm that 
you want to leave the shading function. This confirmation is necessary 
because you have only one chance to shade the chart. Once you leave 
this function you cannot get back to it without starting the chart over from 
scratch. 

Enter Y and the Title menu reappears. 

With one exception to be covered later, the Title functions operate 
exactly as they did when you titled a chart in Lesson One. Use that 
experience and put in the titles to make the chart look like the following 
picture. 
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The legend doesn't add much to the chart with all of the legend infor­
mation on the chart itself. With a pie chart, the LEGEND function erases 
the legend. Whereas the LEGEND function returned the legend in other 
charts, it erases the legend in pie charts. Select LEGEND and press 
RETURN. You should remove the legend before locating titles anywhere 
to the right of the left side of the legend. That entire side of the screen is 
erased to eliminate the legend. 

To try your hand at another pie chart, use the same three series plus the 
WHITE series and use data point 1. 

DISPLAYING TWO CHARTS AT ONCE 

The same data you used for the pie charts is also available in a different 
form in the series 2 MAN RACE and 3 MAN RACE. All the 0 points are in 
2 MAN RACE and the 1 points are in 3 MAN RACE. It is often desirable 
to show the different forms of data at the same time, in two different charts. 

The WINDOW function in the Main Plot menu provides this capability. 
It divides the screen into two parts. You can draw different charts in each 
window. You can put any kind of chart into the windows except the pie 
chart. A pie chart requires the whole screen. 

The WINDOW menu gives you the choice of dividing the screen into 
side by side or top and bottom sections. This example uses top and bottom 
sections. The WINDOW menu also lets you switch between the windows 
and provides a means to return to single window operation. 
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When you enter the WINDOW function, the active window is the top one 
if you chose HORIZ windows and the left window if you chose VERT 
windows. 

When you switch between windows, you lose the current active series 
and option data for the window you are leaving. When you return to the 
window, you must start over if you want to change an option and rePLOT 
the chart. 

The following series of commands assume that you are beginning from 
the Select menu. 

(NONE) RETURN 

(WINDOW) RETURN 

(HORIZ) RETURN 

(BAR) RETURN 

(NORMAL) RETURN 

(2 MAN RACE) RETURN 

(PLOT) RETURN 

RETURN 

(WINDOW) RETURN 
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(SWITCH) RETURN 

(SELECT) RETURN 

(BAR) RETURN 

(NORMAL) RETURN 

(3 MAN RACE) RETURN 

(PLOT) RETURN 
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There are several things to note in the creation of these charts. When 
you are working in one of the windows, the window is indicated by a code 
in the extreme right hand end of the bottom status line. The code begins 
with W for window and T for top or B for bottom. If you use side by side 
windows, the codes are R for right and L for left. 

Legends are not included in charts drawn with the WINDOW function. 
You must create any required legends with the TITLE functions. Also, 
note that the range for these charts is not very meaningful. You can 
inlcude the meaning of the numbers in the legend or replace them with 
the names, or at least, a meaningful code, such as B, G, W, and U for 
Brown, Green, White, and Undecided. 

There are two ways to leave the WINDOW function. You can select 
NEW from the Main menu or NONE from the WINDOW menu. 

The following picture shows one of the ways the charts could be used. 
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A SCATTER CHART 

(N EW) RETURN 

(SeA TIER) RETURN 

(MATH 1) RETURN 

(MATH2) RETURN 

(PLOT) RETURN 

LESSON FOUR 

This chart does not have a time axis. The Y-axis contains the scale for 
the MATHI series and the X-axis contains the scale for the MATH2 
series. No lines are drawn in a Scatter chart, only points. 

The plotted values are points from the two series with matching dates. 
The first point plotted is the time 1 value from each series, the second 
point is the time 2 value, and so on. The normal use of the scatter chart 
is to determine if there is a relationship between the two series. For 
example, a straight line scatter chart shows direct relationship between 
the two series. An analysis of the scatter patterns is beyond the scope of 
this manual. 
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REFERENCE 
This chapter is the VisiPlot Reference. It describes the menu functions, 

error messages, and general VisiPlot concepts. 

There are sections on Range, Scale, and general usage as well as menu 
function descriptions and error messages. 

KEYBOARD USAGE 

ESC RESET 

SPACE BAR LEFT ARROW 001-002 

With the VisiPlot programs, the indicated keys have the following 
usage: 
• The RETURN key issues the command indicated by the cursor in a 

menu, selects a list item indicated by the cursor, or enters data entered 
at the keyboard. 

• The Space Bar marks (and unmarks) list items when multiple selection 
is allowed. When multiple selection is not allowed, the Space Bar 
performs the same function as the RETURN key. 

• The Right Arrow key moves the cursor to the right in a menu and down 
in a list. 

• The Left Arrow key moves the cursor to the left in a menu and up in a 
list. 

• The ESC key corrects errors during data entry by erasing the last dis­
played character. This key also erases the status area when a chart is 
displayed. 

• The Y key is an affirmative response to the prompts to verify your 
request when changing programs, deleting files, and exiting the PIE 
chart shading function. 
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• The CTRL-C key combination interrupts the printing of a chart or 
list. CTRL-C should not be pressed except to interrupt a printing 
operation. 

• The RESET key should never be pressed. If it is accidentally pressed, 
the operation in progress is terminated and you are usually returned 
to the Main menu in the program currently executing-the Main 
Storage Management menu or Main Plot menu. 

THE STATUS AREAS 

The following photographs show the Storage Management and the 
Plot status areas and their components. 

LONG 
PROMPT 

CURSOR ---iii~~';_IJ •• ~IJI.RlRt •• Ii_ 
DATA 

DISKETTE 
ADDRESS 

SERIES 
NAME 

PLOT 
TYPE 

MENU 

COLOR 
CODES 

WINDOW 
CODE (WHEN 
PRESENT) 

• The Long Prompt gives a longer description of the function to which 
the cursor is pointing. 

• The Cursor indicates a menu item. The indicated item is selected 
if the RETURN key is pressed. 

• The Data Diskette Address indicates the disk drive to which LOAD, 
SAVE, INIT, and DELETE operations are directed. 

• The Plot Type indicates the type of chart that was last selected. 
• The Series Name indicates the selected series or the first of multiple 

series selected. 
• The Color Codes indicate the plotting color in use (left) and the back­

ground color in use (right). When multiple series are selected, only 
the first plotting color is shown in the status area. 

• The Window Code indicates that the window mode is active and which 
window is selected: top (Wf), bottom (WB), left (WL), or right (WR). 
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RANGE AND HOW IT IS USED 
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Range is the period of time covered by the chart. The VisiPlot program 
plots range against the X-axis (the horizontal axis). The range does not 
have to be measured in units of time, although it usually is. The range can 
be a reference number assigned to items. The VisiPlot documentation 
treats the range as time bounds because most ranges are measured in 
time: daily, weekly, monthly, quarterly, or yearly. 

The range has two parts, the major range which is usually expressed 
as years and the minor range or the period. The period divides the range 
into subparts. You can divide the range into any number of parts from 1 
(no division) to 99. Normal uses of the period are to divide the year into 
months, quarters, or weeks. The use of both the major and minor range 
is up to you. The major range can be days or weeks or months; it does not 
have to represent years. Likewise, the period can represent anything 
you want it to represent. 

How the Range is Calculated 

The range is calculated before each PLOT from the date information in 
the selected series. The range for a single series is the period from the 
start date to the end date. 

The calculated range for multiple series depends on the type of 
chart being plotted. Line and area charts use the union of the individ­
ual ranges. That is, the start date for the chart is the earliest start date 
in the selected series and the end date is the latest end date jn the 
selected series. Hi-Io, bar, and scatter charts use the intersection of 
the individual ranges. That is, the earliest and latest dates common to 
all selected series are used as the range. 

SERIES 1 

SERIES 2 

SERIES 3 

1970 UNION 198~ I_ ~ .. 
I RANGES I 
I I 
1 I 
I I 
I 1 
.... 1 -----+----+-1 1980 : 

1970 I I 

9 6 1 1 1 7 ;----;-1 ---..... 
1 1985 

1972 -----'-------il 1979 

1976 .. . 
INTERSECTION 

of RANGES 

I 
I 
I 1979 

Union and Intersection of Ranges 
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The maximum number of points in any range is 150 and the minimum 
is 2. The maximum and minimum apply to all resultant ranges of all 
selected series. 

The pie chart is a special case. A pie chart is a comparison of different 
items at a single point in time rather than a comparison of the same item 
at different points in time. 

Changing the Range 

The VisiPlot program always determines a range for whatever series 
are being plotted. There are circumstances where you may want to expand 
or limit that range. The range you specify must have at least two data 
points and no more than 150 data points. It must also have at least two 
data points in common with the selected series. 

The RANGE function in the Options menu provides the means of 
changing the program calculated range. 

SCALE AND HOW IT IS USED 

Scale is the scope of values plotted against the Y-axis (vertical axis). 
The scale is totally dependent on the data being plotted. It may be posi­
tive, negative, or span the zero point. Its incremental units may be a frac­
tion of a single unit or millions or more. 

How the Scale is Calculated 

The program selects a range of values that encompass the highest and 
lowest values in the series. This range is rounded up or down to values 
that are round and even. It then sets a number of divisions that result in 
round and even labels when possible. The number of divisions is usually 
10 but other appropriate numbers will occur. 

The VisiPlot program usually does a satisfactory job of figuring out a 
good scale for your data. There may be times when the values on the 
scale come out unrounded and generally unaesthetic. When this happens 
you should use the RESCALE function in the Options menu to obtain more 
pleasing or meaningful Y-axis labels. 

You must enter data in decimal notation. The program converts large 
and small numbers to exponential notation for display purposes and 
specifies a scaling factor at the top of the Y-axis. 
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Changing the Scale 

The VisiPlot program always determines a scale for whatever series 
are being plotted. There are circumstances where you may want to 
expand or limit that scale. 

The RESCALE function in the Options menu provides the means of 
changing the program calculated scale and the number of divisions. 

When choosing the number of divisions, subtract the low end of the 
scale from the upper value and pick a number of divisions that divide 
evenly into that value. 

THE VISIPLOT MENU FUNCTIONS 

This section describes the VisiPlot menu functions in alphabetical 
order. Along with the menu item descriptions, it lists the program in which 
the function is used and the menu in which it is found. 

The menu flow charts show how to get to the various menus in each 
program. 

flow between the program is always via - > PLOT in the Edit program 
and ->MAIN in the Plot program. 

TO PLOT PROGRAM FROM PLOT PROGRAM . rowr, .. I PLOT 

.. MAIN 

CONTINUE LOAD LOOKUP MAIN STORAGE MAIN 
PRINT ,ELEAR MANAGEMENT <MORE>", EXTENSION 

, DRIVE 
SAVE 

EXIT EDIT INIT 
DELETE 

"--- SLOTE 

. (ESC) 

JUMP DELETE PRINT 

EDIT I INSERT FORMAT UNDO EDIT 
-'" 

COMMAND I 
FILL SPECS NAME START 

I SPECS I PER EXIT 

I MENU I 

I FILL I 
ARlTH INSERT 
GEOMET INTERP EXIT 

L MENU I 

Storage Management Flowchart 001-007 
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TO STORAGE MANAGEMENT 

PLOT PRINT 

FROM STORAGE MANAGEMENT 

SElECT 
MENU 

LINE AREA 
HI-Lo SCAITER 
NONE 

MAIN 
PLOT MENU 

NEW SELECT 

PIX SAVE oVERLA Y 
EXIT HORIZONTAL 
VERTICAL SWITCH 

OPTIONS 

GRID FORMAT TITlE 

Plot Program Flowchart 

PLOT 
-'" 

STORAGE PLOT MANAGEMENT 
MAIN PROGRAM PROGRAM 

Interprogram Flowchart 
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The ARITH function inserts new data into the current series beginning 
at the location of the cursor. The new data is an arithmetic progression. 
You are prompted for the number of points to be inserted and the factor 
by which the preceding point is to be increased or decreased. The new 
data points are inserted immediately following the data point currently 
indicated by the cursor. 

AREA (Plot program-Select menu) 

The AREA function specifies that an area chart is to be drawn. You 
must choose one or more series. When choosing multiple series, all series 
must have the same period. When multiple series are plotted, each series 
overdraws the previous series. You should select the series with the largest 
values first, then the next largest, etc. If the series have mixed values, you 
will not get full detail for either series. In this situation, use the OVERlAY 
function to draw a line graph of one of the series. All area charts are 
plotted from the base line; they are not stacked. 

BACKGR (Plot program-Options menu) 

The BACKGR function sets the background color of the plot. BAC~<GR 
can only be used with LINE, BAR, and AREA charts; it cannot be used with 
PIE, HI-LO, and SCADER charts. This function displays the color menu, 
offering a selection of eight colors. With black and white display moni­
tors, only three backgrounds are available; all non-white and non-black 
colors produce the same halftone on the black-and-white screen. 

The program displays the code for the color in the lower right corner 
of the status area. Two colors are listed; the first is the plotting color and 
second is the background color. 

The BACKGR color is retained until it is explicitly changed with the 
BACKGR function or until it is reset with the NEW function. 

When you change the background color, the VisiPlot program changes 
the plotting color to avoid using the same color for background and plot­
ting and to provide a clear, readable plot. You can change the plotting 
color after changing the background color, if you desire. 

The following table lists the plotting colors the program uses for the 
various background colors. The following plotting colors apply if the 
background color was last selected. The series2 colors apply only when 
multiple series are selected. If a single series is selected and overlayed, 
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the series I color is used. The plotting colors for one and two current series 
are listed. If more than two series are selected, the colors are repeated, 
that is, the third series is plotted in the same color as the first series. 

NOTE: If you want three different colors for multiple series charts, you 
must select the first plotting color with the COLOR option. See COLOR for 
the colors used. 

Table 3-1. Plotting Colors Generated by BACKGR 

LINE AREA AND BAR* 
SELECTED FIRST SECOND FIRST SECOND 

BACKGROUND COLOR COLOR COLOR COLOR 
COLOR (and 3rd) (and 4th) (and 3rd) (and 4th) 

Blackl White White White Green 
Green Black White White Black 
Violet Black White White Black 
Whitel Black Black Black Green 
Black2 White Orange White Blue 
Orange Black White White Black 
Blue Black White White Black 
White2 Black Blue Black Blue 

*Stacked bar charts may be slightly offset from one series to the next due 
to the manner in which the Apple II handles color display. 

BAR (Plot program-Select menu) 

The BAR function specifies that a bar chart is to be drawn. You must 
choose one or more series. When choosing multiple series, all series must 
have the same period. When multiple bar charts are plotted, the bars for 
the various series are stacked on top of each other. That is, the first series 
is plotted on the base line and subsequent series are plotted from the top 
of the existing bars. The series are plotted in the order in which they are 
chosen. 

When selecting a bar chart, you have the choice of full-width bars 
centered on the tick marks or half-width bars located to the left or right of 
the tick marks. The half-width bars are normally used to draw comparison 
charts. A comparison chart requires two selections-the first is PLOT ed 
and the second is OVERLAYed. There may be very slight overlay between 
the left and right bars of a comparative chart. There may also be a slight 
offset at the divisions of stacked bar charts. 

No zero line is drawn for bar charts with negative values. 
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Bar chart bars are displayed in one of three formats: solid, outlined, 
and shaded (outline plus horizontal stripes) bars. 

BOTH (Plot program-Format, Grid, and Unlabel menu) 

The BOTH function specifies that both of the subject items are to be used 
or deleted. In the Format menu BOTH means that plotting symbols and 
lines are used for line charts. In the Grid menu BOTH means that horizontal 
and vertical grid lines are to be drawn on the chart. In the Unlabel menu 
BOTH means that horizontal and vertical labels be erased from the chart. 

BOTTOMn (Plot program-Title menu) 

The BOTTOMn functions specify the titles at the bottom of the chart. n 
is a digit-I, 2, or 3-specifying the first, second, or third bottom title line. 
The bottom titles are limited to. 38 characters each. The titles are centered 
across the bottom of the chart. Y ou must choose between bold and normal 
type face in the titles. The bottom titles cover the legend lines. BOTTOM 1 
is uppermost and BOTTOM3 is the lowest. 

BOLD (Plot program - Title menu) 

The BOLD function specifies that the subject title be displayed in bold 
characters. The alternative to bold titles is normal titles. All fixed titles 
except LEFT can be displayed in the bold typeface. 

CLEAR (Storage Management program-Main menu) 
(Plot program-Options menu) 

In the Storage Management program, the CLEAR function specifies 
that the selected series be erased from the computer memory. You are 
prompted to select all, none, or specific series to be erased. This function 
does not affect the files stored on diskette. 

In the Plot program, the CLEAR function specifies that the range values 
you defined are to be disregarded and the range values stored with the 
series are to be used. This function has no effect if you did not define a 
range. 

COLOR (Plot program-Options menu) 

The COLOR function changes the plotting color used to draw a chart. 
This function displays the color menu, offering a selection of eight colors. 
With black-and-white monitors, only three colors are available; all non­
white and non-black colors produce the same halftone on the black-and­
white screen. 
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The program displays the code for the color in the lower right corner of 
the status area. Two colors are listed; the first is the plotting color and the 
second is the background color. 

The plotting color is changed when the background color is changed. 
See BACKGR for a listing of the plotting colors generated when BACKGR is 
used. The following table lists the colors used for second and third selected 
series when the first plotting color is selected with the COLOR option. Note 
that only two plotting colors are available when BACKGR is used to allow 
the program to select the plotting colors and three plotting colors are 
available when you select the first plotting color with the COLOR option. 
COLOR must be used after BACKGR. Multiple plotting colors only apply 
to multiple selections plotted or overlayed at the same time. The sequence 
is not carried between plotting and overlaying, that is, when a series is 
overlayed, the color sequence starts over with the first color regardless 
of the number of series already plotted. 

Table 3-2. Plotting Colors Generated by COLOR 

SELECTED SECOND THIRD 
COLOR COLOR COLOR 

(and 4th color) (and 5th color) (and 6th color) 

Blackl Green Violet 
Green Violet White 
Violet Green White 
Whitel Violet Green 
Black2 Orange Blue 
Or.ange Blue White 
Blue Orange White 
White2 Blue Orange 

CONTINUE (Storage Management program -various menus) 

The CONTINUE function is used in several functions that display data on 
the screen. If there is more data to be displayed, the CONTINUE function 
displays the next screenfull. When the last screen is displayed, CONTINUE 
exits the function and displays the next menu. 

When used with the PRINT function, CONTINUE means return to the next 
menu without printing the screen contents. 

DEFAULT (Plot program-Color menu) 

The DEFAULT option returns the background and plotting color to the 
initial program selected colors, black 1 and whitel (B1.W1). If you have 
not changed the colors, this option has no effect. When used with the 
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BACKGR function, DEFAULT changes both the background and the plotting 
color. Used with COLOR, it changes only the plotting color. 

DELETE (Storage Management program - Edit commands menu) 
(Storage Management program - Main menu extension) 

In the Edit command menu, the DELETE function deletes selected data 
points from the current series. The deletion begins at the item indicated 
by the cursor when the function is invoked. Moving the cursor to the last 
item specifies the other end 9f the range to be deleted. The cursor can be 
moved up or down on the list. If you move the cursor beyond the end of 
the list, the DELETE function is canceled. 

In the Main Storage Management menu extension, the DELETE function 
deletes selected files from the data diskette. You select the file to be erased 
from the listing of the file directory. Before the file is erased, you are asked 
to confirm that you want to permanently erase the file. 

DIF (Storage Management program-Main menu) 

The DIF function specifies that the series being saved is to be stored in a 
DIF file. Data in this format can be used with other Personal Software 
programs, such as the VisiCalc program. The alternative is the NORMAL 
format, which is only usable by the VisiPlot program. 

The 01 F format is described in Programmer's Guide to the Data 
Interchange Format, document number SATN-18, which is available 
from the DIF Clearinghouse, P.O. Box 527, Cambridge, MA 02139. 

DRIVE (Storage Management program - Main menu) 

The DRIVE function changes the drive number assigned as the data 
diskette drive. If drive 1 is currently assigned, the DRIVE function changes 
the assignment to drive 2 and vice versa. The DRIVE function, along with 
the SLOT function, specifies where the data diskette resides. 

EDIT (Storage Management program - Main menu) 

The EDIT function invokes the Edit facilities. You are prompted to select 
a series from those currently in memory or to create a new series. When 
creating a new series, you are prompted for the name, period, starting 
date, and first data point. See DELETE, EDIT, EXIT, FILL, FORMAT, INSERT, 
JUMP, and SPECS. 
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(Storage Management program -various menus) 

The EXIT function leaves the current menu without performing a func­
tion. Usually, the EXIT function returns to preceding menu. 

FILL (Storage Management program - Edit commands menu) 

The FILL function generates data to be placed in the current series. The 
data can be an arithmetic series, a geometric series, or a series currently 
in memory. You are prompted for the number of values and factor for the 
first two and a series name for the last. In all cases the new data is inserted 
following the item currently indicated by the cursor. FILL also provides a 
linear interpolation function to approximate missing data points. See 
ARITH, GEOMET, INSERT, and INTERP. 

FORMAT (Storage Management program - Edit command menu) 

The FORMAT Edit command specifies how the data is displayed on the 
screen. Unless otherwise specified data is displayed in the floating point 
format. In the fixed format, you can specify the number of decimal places 
(the precision) and the column width (the total number of digits). The 
precision can be 0 to 6 digits and the column width 6 to 15 digits. Numbers 
that are too large for the column size and numbers in the exponential 
format (3E-3 for example) when the fixed format is specified are displayed 
as a series of greater than symbols (». You cannot enter values in the 
exponential format, the program converts numbers less than .001 and 
greater than 9 digits to the left of the decimal point to the exponential 
format. 

FORMAT (Plot program -Options menu) 

The PLOT program FORMAT function specifies how a line, bar, or scatter 
chart is to be displayed. This function is not available for area, pie, and 
hi-Io charts. It displays a different menu for the different supported charts. 
When the function is chosen for an unsupported chart, the message 
CAN'TI NO OPTION HERE is displayed. 

The line chart FORMAT menu allows the choice of plotting with both 
lines and symbols, lines only, or symbols only. 

The bar chart FORMAT menu allows the choice of plotting with solid, 
shaded, or outlined bars. 

The scatter chart FORMAT menu allows the choice of plotting with 
symbols or points. 
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The chart format is retained until changed by another FORMAT func­
tion, until a different type of chart is selected, or until reset by the NEW 
function. 

GEOMET (Storage Management program-Edit commands menu) 

The GEOMET function specifies that new data is to be inserted into the 
current series in a geometric progression. You are prompted for the num­
ber of data points to be generated and for the factor by which each pre­
ceding point is to be multiplied. The data points are inserted immediately 
following the data point currently indicated by the cursor. 

GRID (Plot program-Options menu) 

The GRID function draws grid lines on the currently displayed chart. 
The function is valid for all charts except pie charts. It offers the choice 
of vertical, horizontal, or both vertical and horizontal grid lines. You can 
erase grid lines by selecting them for a second time. For example, by 
selecting horizontal grid lines while horizontal grid lines are displayed 
erases the lines. You can erase horizontal, vertical or both. You cannot 
invoke this option until a chart is displayed. 

HI-LO (Plot program -Select menu) 

The HI-LO function specifies that a HI-LO chart is to be drawn. You must 
select two series. You are prompted to select the high series and the low 
series. You can select the series in either order, the program distinguishes 
between the high and low values. You cannot generate HI-LO charts with 
multiple sets of series, but you can overlay the charts. A HI-LO chart is 
displayed as a series of vertical lines connections the high and low values. 
The vertical lines are not connected from time period to time period. 

If you OVERLAY a HI-LO chart with a line chart, the line chart is plotted 
with points only. The points appear slightly to the right of the vertical 
lines. This feature makes it easy to generate stock charts showing high, 
low, and close. If you want to overlay a line chart with lines and/or sym­
bols, you must select the format option. 

HORIZ (Plot program-Grid, Unlabel, and Window menus) 

The action of the HORIZ function depends on the menu from which it 
is invoked. 

In the GRID function it specifies that horizontal grid lines are to be 
drawn. If horizontal grid lines already exist, this function erases them. 

In the UN LABEL function it specifies that the horizontal range labels 
(X-axis) are to be erased. 
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In the WINDOW function it specifies that the screen is to be divided into 
top and bottom windows as opposed to side by side windows. 

INSERT (Storage Management program-Edit command menu) 
(Storage Management program-Edit Fill menu) 

In the Edit command menu, the INSERT function inserts a new data point 
anywhere within the selected series. The new point is inserted immediately 
preceding the data point at the current cursor location. The points that 
follow this point are pushed ahead to the next year and/or period. The 
last point in the series is given a new end date one period beyond the old 
last point. 

In the Fill menu, the INSERT function inserts a selected series from 
memory into the currently displayed series. The new data immediately 
precedes the data point at the current cursor location. The new data is 
given the date of the current cursor location. The points that follow are 
pushed ahead and given new dates and/ or periods as appropriate. 

JUMP (Storage Management program-Edit command menu) 

The JUMP function moves the cursor to a specific date in the currently 
displayed series. You are prompted for the date. With the arrow keys you 
can move the cursor to the beginning or end of the series. The right arrow 
key specifies the end of the series and the left arrow key specifies the 
beginning. 

LEFT (Plot program - Title menu) 
(Plot program-Bar Chart menu) 

In the Title menu, LEFT specifies that a title is to be placed to the left of 
the Y-axis. The left title is written vertically from top to bottom. It is centered 
to the left of the chart. The left title is limited to 18 characters. The UN LABEL 
function erases the left title. If you have created left and right windows, 
you can put a different LEFT title in each. In the window mode, a single 
LEFT title is drawn when top/bottom charts are displayed and separate 
LEFT titles are drawn when left/right charts are displayed. 

In the Bar Chart menu, LEFT specifies that half-width bars are to be 
drawn and placed to the left of the tick marks. LEFT, along with RIGHT, is 
usually used for comparative bar charts. 

LEGEND (Plot program - Title menu) 

The LEGEND function redisplays the chart legend after it has been 
erased by a bottom title. If you OVERLAY a chart after entering the bottom 
titles, the LEGEND function displays the legend for the overlaid chart, not 
the original legend. This function erases all bottom title lines that covered 
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legend lines. Any bottom title lines that didn't cover a legend line are not 
erased. With a pie chart, LEGEND erases the pie chart legend. Once the 
pie chart legend is erased, it cannot be redisplayed. 

LINE (Plot program-Select menu) 

The LINE function specifies that a line chart is to be drawn. You must 
choose one or more series. When selecting multiple series, all must have 
the same period. When multiple series are selected, the progam draws 
each with a different symbol. The first uses the square box, the second 
uses a diamond, and the third uses the pound sign. If more than three 
series are selected, the three symbols are reused. The legend lists the 
names of the first three plotted series, and the symbol used for each. Only 
the first three selected series are listed in the legend. 

LINES (Plot program-Format menu) 

The LINES function specifies that the line chart being drawn is to be 
drawn with interconnecting lines and without symbols. This function is 
only valid for the line chart. 

LOAD (Storage Management program-Main menu) 

The LOAD function loads a file from diskette. Files contoin one or more 
series. You are prompted to select a file name from the directory of 
the current data diskette. The SLOT and DRIVE functions are used to 
change the disk drive used for the data diskette. 

If the out of room condition occurs, a partial load is performed if 
possible. As many series from the file as can be put into memory are 
loaded. The partial load only occurs with files stored in the normal 
VisiPlot storage format. Partial loads are not done with files in the 
DIF format. 

LOOKUP (Storage Management program - Main menu) 

The LOOKUP function lists the data series that are currently in memory. 
The display includes the series name, period, start date, end date, and 
number of data points in the series. Presents any key returns to the Main 
Storage Management menu. The program displays the LOOKUP list after 
each LOAD and CLEAR. 

-> MAIN (Plot program - Main Plot menu) 

The - > MAIN function exits the Plot program and returns to the Storage 
Management program. You must verify that you want to change programs 
by responding to the prompt with Y. 
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The MOVEABLE function places titles anywhere on the chart. A move­
able title is limited to 32 characters. 

This title is initially displayed at the left center of the chart. When first 
displayed, the title blinks; it continues to blink until it is fixed in place by 
pressing the RETURN key. 

As the name implies, the title can be moved to any location on the 
screen. Movement is controlled by the I, J, K, and M keys and the space 
bar. The location of these keys indicates the direction they move the title: 

UP 

Iccl 
LEFT ICDI ICKJI RIGHT 

~ 
DOWN 001-004 

The space bar stops the movement. 

When you press a motion key, the title begins moving in the indicated 
direction until another motion key is pressed, the space bar is pressed, or 
the title runs into the outside limits of the chart. When the outside limit is 
reached, a beep is repeated until the motion is stopped or reversed. The 
number key, I through 9, control the speed; 1 is the slowest speed and 9 
is the fastest. You can change speed during movement. Pressing a speed 
key starts motion again, in the last direction. If you don't choose a speed, 
2 is used. 

You can delete the moveable title at any time by pressing the ESC key. 
Before a moveable title is fixed in place, its deletion does not affect what 
is under it. After it is fixed in place it can still be erased but anything 
under it is also erased. 

When the title is fixed, it is displayed in reverse video. Pressing the 
space bar changes it to normal video. Subsequent pressing of the space 
bar changes it back and forth. When you press RETURN the second time, 
the title is permanently fixed in either normal or reverse video. After the 
second RETURN, it can no longer be deleted. The second RETURN also 
returns you to the Title menu. 

There is no limit to the number of moveable titles that can be put on a 
chart. 
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NAME (Storage Management program-Edit Specs menu) 

The NAME function changes the name of the series being edited. 

NEW (Plot program - Main Plot menu) 
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The NEW function clears the screen and deletes the currently active 
series. It also deletes any options you have set. NEW resets the default 
plotting and background colors. It returns to single window operation if 
two windows are set. The NEW function also calls the Select menu. 

NONE (Plot program-various menus) 

The NONE function exits from a menu without making a selection. 
NONE usually returns to the menu that called the current menu. 

NORMAL (Plot program-Title menu) 

(Plot program-Bar menu) 

(Storage Management program-Save menu) 

In the Title menu, NORMAL specifies that the subject title is to be dis­
played in the normal, as opposed to bold, typeface. 

In the Bar menu, NORMAL specifies that the chart be drawn with full­
width bars centered on the tick marks. 

In the Save menu, NORMAL specifies that a series is to be stored in the 
normal VisiPlot storage format, as opposed to the DIF format. In the 
normal format, the data can only be used with the VisiPlot program. The 
VisiPlot storage format is described in Appendix C. 

OPTIONS (Plot program-Main Plot menu) 

The OPTIONS function calls the Options menu, which provides the 
means of changing certain plotting and formatting values such as range, 
scale, color, background, and format. It also provides the facilities to add 
titles to a chart. For more information see TITLE, RANGE, FORMAT, GRID, 
UNLABEL, RESCALE, BACKGR, and COLOR. 

OVERLAY (Plot program - Main Plot menu) 

The OVERLAY function draws a chart on top of an existing chart, unlike 
the PLOT function which erased the existing chart before drawing a new 
one. OVERLAY does not compute range or scale values, it uses the existing 
values of the current chart. If the chart to be overlaid does not fit in the 
existing range and scale, an error message is issued. 

3-17 



VISIPLOT™ USER'S 
GUIDE 

No legend is displayed for the overlaid chart. 

A chart must be displayed before OVERLAY can be used. 
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The chart being overlaid must have the same period as the existing 
chart. You cannot change the RANGE, SCALE, or BACKGR between a 
PLOT and an OVERLAY. 

If you follow an OVERLAY function with a PLOT function, only the last 
selected series is or are drawn, that is, the series selected for the OVERLAY, 
not for the original PLOT or previous OVERLAY. 

All types of charts except pie charts can be overlaid. Chart types­
with the exception of pie charts-can be mixed with the OVERLAY 
function. 

PER (Storage Management program-Edit Specs menu) 

The PER function changes the period of an existing chart. The function 
shows whot the current period is and prompts for a new one. The valid 
periods are 1 through 99. If you don't enter a new period, the existing 
one is used. If you specify a new period, the currently displayed series is 
erased and redisplayed with the new period. The current beginning date 
is retained. 

PIE (Plot program-Select menu) 

The PIE function specifies that a pie chart is to be drawn. A pie chart 
consists of a circle that is divided into segments. The size of each segmel].t 
is proportional to the ratio of the segment data value to the sum total of all 
the data values. 

An individual pie chart compares the values at a specified date or 
reference number of two to eight series. It does not compare the different 
values in a single series. It is possible to do a pie chart for a single series 
but resulting chart is a circle and the single series has a percentage of 
100%. 

In a pie chart the segments are drawn in a clockwise direction begin­
ning at the 3 0' clock position. You are prompted for the date or reference 
number of the data. Each selected series must have a value for the speci­
fied date. If some series have very small relative values that result in small 
percentages, the legend letters around the chart may overlap. If this 
occurs, change the order in which the series are selected so that small 
segments are not side by side. 
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The pie chart is drawn with a letter outside the segments that corre­
sponds to a line in the legend. The legend is in a box to the right of the 
chart that contains the series name and its relative percent of the total. 
The date or reference number of the data is displayed at the bottom of the 
legend. Because of rounding, the percentages listed in the legend may 
not add up to 100%. 

The shading and titling prompts are displayed. You may title, shade, 
and title again. This sequence is fixed and once you have finished the 
second title phase, you cannot alter the pie chart. All the usual titling 
capabilities apply. You can erase the legend with the LEGEND function of 
the Title menu. This use of the LEGEND function applies only to pie charts. 

PIXSAVE (Plot program-Main Plot menu) 

The PIXSAVE function saves the screen image on a diskette file. The 
PIXSAVE file cannot be reloaded into the VisiPlot program. It can be used 
with user-supplied programs, such as screen dumps for graphic printers. 
You are prompted to put a data diskette in the data diskette drive. The 
PIXSAVE file does not show up on the VisiPlot directory; it will, however, 
show up on the DOS 3.3 CATALOG command. Appendix A contains a 
listing of a simple program that prints a PIXSAVE file. 

PLOT (Plot program-Main Plot menu) 

The PLOT function specifies that the currently selected data series is to 
be plotted according to the current options. The PLOT function erases an 
existing chart. The error message PLEASE SELECT FIRST is displayed if no 
series is selected. After the chart is drawn, pressing any key returns the 
Main Plot menu to the screen. 

-> PLOT (Storage Management program-Main menu) 

The - > PLOT function specifies that the Plot program is to be loaded. 
Yau must verify that you want to change programs by pressing the Y key 
in response to the message lYPE Y TO CONFIRM. If you press any other 
key, the request to change programs is cancelled. 

PRINT (Plot program - Main Plot menu) 

(Storage Management program-various menus) 

The PRINT function reproduces the screen image on the supported 
printer. The printer controller can be plugged into any slot (slot I is rec­
ommended). This function prompts for the slot number. CTRL-C inter­
rupts the function and returns to the menu from which PRINT was issued. 
If the printer is not recognized in the specified slot, an unrecoverable 
error occurs and you must re-load the program and begin again. 
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To print graphs on printers that are not supported by the VisiPlot 
program, see PIXSAVE. 

QUIT (Storage Management program-Main Menu) 

The QUIT function returns control to Applesoft Basic. The Applesoft 
prompt (]) is displayed. To return to VisiPlot program you must enter the 
command: RUN INIT. All files you have in memory when you select 
QUIT are erased, you must LOAD them again after reloading the VisiPlot 
program. 

RANGE (Plot program-Options menu) 

The RANGE function calls the Range menu. The Range menu displays 
the current series range. The RANGE menu lets you SET a new range or 
CLEAR a range you have previously SET. When SET is chosen, it prompts 
for new starting and ending dates. The chart is not redrawn until the 
PLOT function is executed. You also have the option to CLEAR a user-set 
range. CLEAR has no effect on the range if you have not changed it with 
the SET option. You also have the option of exiting the function. See the 
description of range for a description of how the VisiPlot program sets 
ranges for different chart types. 

RESCALE (Plot program -Options menu) 

The RESCALE function changes the Y-axis scale established by the 
program. The function prompts for a new minimum and a new maximum 
value. It also requests the number of divisions into which the Y-axis is to 
be divided (tick marks). For a scatter chart, it also prompts for maximum, 
minimum, and number of divisions for the X-axis. 

If you specify a minimum that is greater than the maximum, the Visi­
Plot program reverses the values. If you specify the same value for the 
minimum and maximum, the program uses the specified value as the. 
minimum and sets a maximum that is approximately 20 percent higher. 

See the Scale section for a description of how the VisiPlot program sets 
scales for the charts. 

RIGHT (Plot program-Bar menu) 

The RIGHT function specifies that a bar chart is to be drawn with half­
width bars located to the right of the tick marks. This function, along with 
the LEFT function, is used to draw comparative bar charts. 
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The SAVE function writes one or more series to a diskette file for perma­
nent storage. You must choose whether the data is to be saved in the 
normal VisiPlot format or the DIF format. After you select a format, the 
function displays a list of the series currently in memory and requests 
that you select those to be saved. It then displays a list of the files currently 
on the data diskette. You can choose to store the selected series in an 
existing file or create a new file. If you choose an existing file, the data 
that is currently in that file is erased and replaced by the new series. If 
you choose to store the series in a new file, you are prompted to name 
the file. If you do not specify a name, the SAVE request is cancelled. 

SCATTER (Plot program-Select menu) 

The SCA TIER function specifies that a scatter chart is to be drawn. You 
are asked to select the series to be plotted along the X-axis and the Y-axis. 
The X-axis is scaled to the minimum and maximum for the X-axis series 
and the Y-axis is scaled correspondingly for the Y-axis series. The range 
of a scatter chart is the intersection of the two series and is not explicitly 
shown in the chart. You can change the range. 

A scatter chart can be drawn with points or plotting symbols. If you 
don't make a choice with the FORMAT function, plotting symbols are used. 

When you RESCALE a scatter chart, you are asked for new scale values 
for both the X- and Y-axis. 

The X-axis scale factor, when required, is displayed below the X-axis. 

SELECT (Plot program-Main Plot menu) 

The SELECT function calls the Plot program Select menu from which you 
can select the type of chart to be drawn. The SELECT function does not 
eliminate the current active series until a new chart is selected and it does 
not change the current options in effect. You can keep the currently 
active series by choosing NONE and returning to the Main menu. To 
eliminate the current active series and the current options you have set, 
use the NEW function to call the Select menu. 

The selected series name is displayed in the bottom line of the Main 
Plot status area. If you select multiple series, the name of the last one 
selected is displayed in the status area. When you select multiple series, 
the chart type in the Main Plot status area is followed by an ellipsis ( ... ). 
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The SET function sets a new range for the series. You are prompted to 
enter new start and end dates for the new range. The range you set can 
be eliminated with the Range menu CLEAR function. 

SLOT (Storage Management program-Main menu) 

The SLOT function changes the currently assigned slot number for the 
data diskette drive. After the program is loaded, the slot from which the 
program was loaded is used as the data diskette slot number. When the 
SLOT function is selected, the slot number is changed to the next lower 
consecutive slot if it contains a disk drive controller. If there is no controller 
in the next lower slot number, the SLOT function is ignored. 

If you have disk drive controllers in slots 5 and 6 the SLOT function 
switches between them. If you have controllers in slots 4, 5, and 6, the 
function switches from 6 to 5 to 4 to 6 and so on. If you have controllers 
in slots 4 and 6, the function is ignored. 

The VisiPlot program is loaded from the controller plugged into the 
highest slot number. 

SPECS (Storage Management program-Edit commands menu) 

The SPECS function changes the specifications of the current series. 
The specifications that can be changed are the name of the series, the 
period, and the start date. For further information see NAME, PER, and 
START. 

START (Storage Management program-Edit Specs menu) 

The START function changes the starting date of the current series. The 
series dates are changed immediately and shown in the display. 

SWITCH (Plot program - Window menu) 

The SWITCH function switches from one window to the other when the 
program is in two-window mode. This function does not affect the chart 
displayed in the current window. The current window designation, which 
is in the lower right corner of the status area, is changed to show the 
window that is being used. 

When you switch windows, the chart in the window you leave is frozen. 
You cannot return to the window and make changes to it; you must 
return to the window and start over with the selection process. 
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The SYMBOLS function specifies that a chart is to be drawn with plotting 
symbols alone (no interconnecti~g lines). This function is used in the For­
mat menu for line and scatter charts. 

TITLE (Plot program-Options menu) 

The TITLE function calls the Title menu, which contains the functions 
to add top, bottom, left, and moveable titles to the currently displayed 
chart. For more information see TOP, BODOM, LEFT, LEGEND, and MOVE­
ABLE. 

TOP (Plot program-Title menu) 

The TOP function centers a title over the displayed chart. The top title 
is limited to 38 characters. You are prompted to enter the title and then 
asked if it should be displayed in normal or bold typeface. You return to 
the Title menu from the TOP function. 

UNDO (Storage Management program-Edit commands menu) 

The UNDO function discards all changes made to a series during an 
editing session. This function restores the series to the condition it was in 
when it was selected for editing. When you UNDO a newly created series, 
it is deleted. 

UNLABEL (Plot program-Options menu) 

The UNLABEL function erases the X- and/or Y-axis labels. The function 
displays the Unlabel menu which offers the choice of erasing horizontal 
(X-axis) labels, vertical (Y-axis) labels, or both. You can also exit the 
function without erasing either. When the vertical labels are erased, a left 
title is also erased if it is present. If no chart is displayed, this function 
immediately returns to the Main menu. 

VERT (Plot program-Grid, Unlabel, and Window menus) 

The VERT function specifies that the currently selected function is to be 
performed in a vertical manner. 

In the Grid menu, VERT draws vertical grid lines on the current chart. 

In the Unlabel menu, VERT erases the current vertical labels. 

In the Window menu, VERT divides the screen into side by side windows. 
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The WINDOW function divides the screen into two windows, switches 
between the windows, and changes back to a single, full screen window 
format. This function divides the screen into a horizontal configuration 
with top and bottom windows or a vertical configuration with side by side 
windows. 

The chart legends are not displayed in the window mode. 

The window mode is displayed in the extreme lower right corner of the 
status area. If the area is blank, the screen is not divided into two windows. 
When the screen is divided, the codes WI, WS, WL, or WR are displayed, 
indicating that the current window is the top, bottom, left or right window. 

The two-window mode is cancelled by selecting NONE from the Window 
menu. It is also cancelled by the NEW function from the Main Plot menu 
and when a pie chart is selected. 
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The following are the error messages issued by the VisiPlot program. 
The messages are in alphabetical order by the first word of the message. 
The error descriptions include suggestions on further action whenever 
possible. If an error message with a number appears, see The DOS 
Manual, Apple product number #A2L0036. 

(beep) 

A beep is sounded whenever inappropriate data is entered or an 
illegal operation is attempted. When inappropriate data is entered, 
no message is displayed, only the beep is sounded. When you 
encounter this, try your entry again. You probably pressed the 
wrong key by mistake, such as pressing a letter key when the 
program was looking for numeric data. 

CAN'T! BAD PERIODICITIES 

You selected series that have different periods. All series used in a 
chart, whether a multiple series chart or an overlay of two or more 
charts, must have the same period. 

CAN'T! BAD RANGE 

Several conditions can cause this message to be issued: 
• There is no data in the range you specified with the RANGE 

function. 
• There are more than 150 points in the range. For example, you 

tried to plot two series and the combined ranges of the two series 
exceeds 150 points. 

• You attempted to draw a scatter chart with two series that have 
no common values at any date. 

• You attempted to draw a pie chart with one or more series that 
have no data at the date specified for the pie chart. 

CAN'T! ERROR: DISK I/O or DISK ERROR 

This error can be caused by disk problems such as having the drive 
door open, no diskette in the drive, and a full diskette. 

CAN'TI ERROR: WRITE PROTECTED 

You attempted to save some series in a file on a write-protected disk­
ette. Either replace the data diskette with one that is not write-pro­
tected or remove the write disable tab from the diskette. You should 
determine why the diskette was write-protected before removing 
the write disable tab. 
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Certain options are not applicable in all instances. When you see 
this error message, you tried to apply a function that is not legal in 
the current circumstances. Usually, an option can be applied 
wherever it is meaningful and useful. Some of the invalid uses of 
options are: 
• Specifying GRID when no chart is displayed on the screen. 
• Specifying the FORMAT option after selecting the COLOR or 

BACKGR options. (Plotting symbols do not appear properly in 
color or against colored backgrounds. 

• Specifying BACKGR or COLOR for a pie, scatter, or hi-lo chart. 
Pressing any key except RESET returns to the main menu. 

CAN'T! NO OVERLAY HERE 

You attempted to use the OVERLAY function when there was no chart 
displayed. Or you specified COLOR or BACKGR and then immedi­
ately tried to overlay. You can select COLOR or BACKGR, then PLOT, 
and then OVERLAY another series. 

CAN'T! PLEASE SELECT FIRST 

You attempted to select the OPTIONS functions without first selecting 
a series. Select a series and then return to the OPTIONS function. 

CAN'T! PRESS ANY KEY 

You are drawing a bar chart that has an off-scale data point. This 
message occurs when the first off-scale bar is encountered. The 
VisiPlot program does not draw bar charts with off-scale data. This 
error also occurs if you press CTRL-C or RESET while drawing a 
graph. 

DATA OFF SCALE: Y TO DISPLAY 

You rescaled the chart and in the new scale, some data points fall 
outside the specified scale. Pressing Y causes a partial plot to be 
drawn. Each time an off-scale value is encountered, the beep 
sounds. Pressing any other key aborts the drawing of the chart. If 
the chart is a bar chart, the plot is aborted when the first off-scale 
data point is encountered. 

NO ACTIVE SERIES 

You attempted to invoke a function that cannot be invoked until a 
series is selected through the Select menu. You may have switched 
windows and forgotten to select a series for the new window. You 
must select a series after switching windows, even if you want to 
plot the same series. 
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You tried to LOAD a file when there was not enough room in memory 
to hold all the series in th~ file. You must CLEAR enough series out 
of memory to make room for the series in the file. 

It is possible to get this error message if a non-VisiPlot file, that 
because of its format is mistaken for a VisiPlot file, is loaded. 

PUT IN PROGRAM DISKETTE, PRESS ANY KEY 

You tried to change programs when the VisiPlot program diskette 
was not in the boot slot. Insert the VisiPlot program diskette and press 
any key except RESET to continue. 

PLEASE SELECT FIRST 

You selected the PLOT or OPTIONS function when there was no cur­
rent series to be plotted. You may have switched windows; you must 
use the SELECT function to select a series after switching windows, 
even if you want to plot the same series. 

UNABLE TO LOAD: WRONG FORMAT 

You attempted to load a file that is not in the VisiPlot data format 
or the DI F format 

WON'T! THIS IS THE PROGRAM DISKETTE 

You selected the INIT function and the drive that the program found 
in the data diskette drive is the VisiPlot program diskette. Initializing 
a diskette destroys everything on it. You cannot continue because 
you would destroy your program diskette. 

3-27 





Pc=JSONAL SO;=rwA=tC™ APPENDIXA 
VIS/~LOT ™ ~t~~i 

APPENDIX A: 

SAMPLE PRINT PIXSAVE PROGRAM 

The following program prints a chart that was saved on diskette in 
binary format with the PIXSAVE function in the Plot program. This 
program assumes: 
• The VisiPlot program diskette is in Drive 1 and contains the printer 

driver program under the name VISIPLOT.DRIVER. 
• The data diskette is in Drive 2 and contains the PIXSAVE file that is to 

be printed. The sample program uses the name PLOT .PIX; change 
this to the name of your file. 

• The printer interface card is plugged into Slot 1. The slot number is 
defined in the SLOT = 1 statement. If your printer is plugged into 
slot 5, you would enter the statement as SLOT = 5. 

To create a program and save it on the program or any other diskette, 
enter the following: 

NEW 
1 REM DEFERRED MODE EXAMPLE 
10 D$ = CHR$( 4) 
20 SLOT = 1 
30 PRINT D$; "BLOAD VISIPLOT.DRIVER,D l,A$987C3" 
40HGR 
50 PRINT D$; "BLOAD PLOT .PIX,D2,A$2000" 
60 POKE 39118,SLOT 
70 PRINT D$; "PR#" ;SLOT 
80 CALL 39125 
90 TEXT 
100 PRINT D$; "PR#O" 
110 END 
SAVE-name 

See The DOS Manual for details on saving a program on diskette and 
the Applesoft Basic Programming Reference manual for details on 
entering a program in deferred mode. 

A-I 



VISIPLOT™ USER'S 
GUIDE APPLE II 

APPENDIXA 

You can also enter a series of commands in immediate mode and have 
them executed as you enter them. This series of commands must be 
entered each time you want to print a chart. 

D$ = CHR$(4) 
SLOT = 1 
HGR 
BLOAD PLOT .PIX,D2,A$2000 
POKE 39118,SLOT 
PRINT D$, "PR#" ;SLOT 
CALL 39125 
PRINT D$; "PR#O" 
TEXT 

NOTE: When you enter statements in immediate mode, the statements 
may not appear on the screen after typing HGR. This is a normal con­
dition, not an error. TEXT restores the screen to normal (non-graphics) 
mode. 

See the Applesoft Basic Programming Reference manual for 
details about entering commands in immediate mode. 
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APPENDIXB: 

SUPPORTED GRAPHIC PRINTERS 

The VisiPlot program supports the following graphic printers: 

• Apple Silentype 
• IDS Paper Tiger 440 and 445 (with graphics option installed) 
• NEC Spinwriter 5510,5515,5520, and 5525 (with NEC-graphics option 

installed) 
• Trendcom 200 

Any printer and model not specifically mentioned is not supported. 

In support of these printers, the VisiPlot program diskette contains 
several driver programs. The program uses only one printer driver that 
must be named VISIPLOT.DRIVER. To use a different printer you 
must RENAME one of the supplied drivers on the program diskette to 
VISIPLOT.DRIVER. 

The program comes with the driver for the Apple Silentype stored 
as VISIPLOT.DRIVER. If you use a different printer, first rename 
VISIPLOT .DRIVER to SILENTYPE.D and then rename the driver for 
your printer to VISIPLOT.DRIVER. It is advisable to write down the 
name of the driver that you rename VISIPLOT.DRIVER. Use the same 
names if you change drivers, this could save you considerable trouble if 
you change printers often. To change the names you must use the DOS 
3.3 RENAME command. Be sure to remove the write disable tab before 
attempting to RENAME a driver file. Also be sure to replace the write 
disable tab after changing the names. 

When using the printer drivers, it is your responsibility to position the 
paper in the printer before you request the printing of listings or charts. 
No automatic form feeds, top of form, and so forth are provided. 

Table B-1 lists the driver names for the various configurations of the 
supported printers. The references to double width graphics and auto 
linefeeds are software functions, not hardware options. You need no extra 
equipment to use them. Auto linefeed means that the printer driver auto­
matically supplies a linefeed after each carriage return. If your printing 
comes out double spaced and you are using an auto linefeed driver, use 
the corresponding non-auto linefeed driver. If your printing comes out all 
on the same line and you are not using an auto linefeed driver, use the 
corresponding auto linefeed driver. 
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TABLE B-l. Drivers for the Supported Printers 

PRINTER DRIVER NAME DESCRIPTION 

Apple SILENTYPE.D Apple Silentype Printer / 
Silentype Interface 

SILENTYPE-DW.D Apple Silentype w/double 
width graphics 

IDS Paper IDS-44X-S.D IDS 440G/445G w/ Apple 
Tiger Serial Interface 

IDS-44X-S-LF.D IDS 440G/445G w/ Apple 
Serial Interface w / auto line£eed 

IDS-44X-P.D IDS 440G/445G w/ Apple 
Parallel Interface 

IDS-44X-P-LF.D IDS 440G/445Gw/ Apple 
Parallel Interface w /auto 
line£eed 

NEC NEC-SPINW -S.D NEC Spinwriter w/ Apple Serial 
Spinwriter Interface 

NEC-SPINW -S.LF.D NEC Spinwriter w / Apple Serial 
Interface w / auto line£eed 

NEC-SPINW-P.D NEC Spin writer w / Apple 
Parallel Interface 

NEC-SPINW-P-LF.D NEC Spinwriter w/ Apple 
Parallel Interface w /auto 
line£eed 

Trendcom TRENDCOM.D Trendcom 200 printer/interface 

TRENDCOM-DW.D Trendcom 200 w / double width 
graphics 
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PRINTER SUPPORT FOR NON-GRAPHIC PRINTERS 

If you have a printer other than the supported graphic printers, you can 
print listings but not charts. Textual printing is supported for specific 
interfaces as opposed to specific interface/printer pairs. There are four 
printer drivers for the Apple parallel and serial interfaces with and with­
out automatic linefeed. The drives are listed in Table B-2. 

TABLE B-2. Drivers for the Text-only Interfaces 

INTERFACE DRIVER NAME DESCRIPTION 

Parallel TEXT-P.D Apple Parallel, w / 0 auto linefeed 

TEXT-P-LF.D Apple Parallel, w / auto linefeed 

Serial TEXT-S.D Apple Serial, w / 0 au to linefeed 

TEXT -S-LF.D Apple Serial, w / auto linefeed 

IDS PAPER TIGER 440/445 

You must have the graphics option to print VisiPlot charts. The graphics 
option is denoted by- a G in the model number i.e. 440G and 44SG. With­
out the graphic option, you can print only listings, not charts. 

Serial Operation 

For operation with the Apple Serial Interface card, the P8 PROM, not 
the P8A PROM, must be installed in the interface card. 

The Baud rate limit is 1200. 

The DIP switch settings for use with the VisiPlot program and a serial 
interface card are: 
DIPS4 SWl,2 -character density-user choice 

SW3 -lines per inch-user choice 
SW 4 -auto page ship-user choice 
SWS -auto linefeed -user choice (select correct driver to 

match setting) 
SW6 -remote printer control deselect-Off 
SW7 -power source-Off is 60 Hz. 
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DIPS5 SWI,2,3-page size-user choice 
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SW 4,5 -must match serial card baud rate selection 
SW6 -graphics print capability enable-On (switch is mean-

ingless if no graphic option) 
SW7 -serial EIA interface selection-On 

You must use a cable that directly connects pins 2, 3, and 7 directly 
between the male and female ends. The lines connecting pins 2 and 3 
must not be swapped. 

The switches on the Apple Serial Interface card should be set as follows: 
1,2,3-baud rate, up to 1200 baud maximum 
4 -off-carriage return delay enabled 
5,6 -according to paper size (must not be set to on/on) 
7 -on -auto linefeed disabled (preferred) the setting does 

not matter; it is overridden by the driver 

Parallel Operation 

To use the Apple Parallel Interface card use the following DIP switch 
settings on the printer: 
DIPS4 SWI,2 -character density-user choice 

SW3 -lines per inch-user choice 
SW 4 -auto page ship-user choice 
SW5 -auto linefeed-user choice (select correct driver to 

match setting) 
SW6 -remote printer control deselect-Off 
SW7 -power source-Off is 60 Hz. 

DIPS5 SWI,2,3-page size-user choice 
SW 4,5 -not used with parallel operation; applies only to serial 

operation 
SW6 -graphics print capability enable-On (switch is mean-

ingless if no graphic option) 
SW7 -parallel TTL interface selection-Off 

NEe SPIN WRITER 5510, 5515, 5520, and 5525 

The NEC Spinwriters require the NEC-compatible graphics option. 
They will not operate correctly with the VisiPlot program if the Diablo­
compatible graphics option is installed. 
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The switches on your Spinwriter should be set at the follow"ing: 
SPEED-same as speed set on interface card 
PARITY -same as parity set on interface card 
DUPLEX -not applicable 
LOCAL LF -off 
LF-6 
SP-IO 
FORM LENGTH-as appropriate for paper in use 
REMOTE/LOCAL-remote (if present) 
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GUIDE 

If your Apple Serial Interface card has the P8 PROM, the serial opera­
tion speed cannot exceed 300 baud. If the P8A PROM is installed, the 
speed cannot exceed 1200 baud. 

The Spinwriter may beep and not start printing when you first attempt 
to print after the Apple II is powered-on. To clear this, press the RETURN 
key on the Apple keyboard. 

APPLE SILENTYPE 

No set-up is required. Use the printer driver that matches your 
configuration. 

TREND COM 200 

No set-up is required. Use the printer driver that matches your 
configuration. 
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APPENDIX C: 

THE VISIPLOT INTERNAL DATA FORMAT 

VisiPlot data series can be stored in either of two formats: the VisiPlot 
data format and the DIF format. Data is stored in the VisiPlot data format 
when you select NORMAL from the SAVE format menu. It is stored in the 
DIF format when you select DIF. Data in the DIF format can be used by 
other Personal Software progrqms. 

The VisiPlot data format is described in this appendix. The DIF format 
is described in the document Programmer's Guide to the Data Inter­
change Format, number SATN-18 which is available from the DIF 
Clearinghouse, P.O. Box 527, Cambridge, MA 02139. 

A VisiPlot data file is an Apple Sequential Text File which is described 
in The DOS Manual, Apple number A2L003S. The fields are variable 
length and each field is terminated with a RETURN. The following list 
contains a description of the contents and, in parentheses, the limitations 
on and expected contents of the fields. 

The fields of a data file are: 
Number of series (I-IS) 
Series name (string-up to 14 characters) 
Number of data points (1-150) 
Periodicity (1-99) 
Start year (0-2499) 
Start period (I-periodicity) 
End year (must be consistent with the start year and period, the 
End period periodicity, and number of points) 
Data point 1 
Data point 2 

• 
• 
• 

Data point n 
• 
• 
• 

The following is the listing of a sample file containing two series, named 
FIRST and SECOND. FIRST has a period of 1 and contains five data 
points beginning at date 1. The values of the data points are 100,200,300, 
400, and,SOO. Second has a period 1 and contains 3 data points beginning 
at date 1980. The values of the data points are 1111, 2222, and 3333. 
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FIRST 
5 
1 
1 
5 
1 
100 
200 
300 
400 
500 
SECOND 
3 
1 
1980 
1 
1982 
1 
1111 
2222 
3333 
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number of series in file 
series name 
periodicity 
start date 
start period 
end date 
end period 

data points 

second series 

first series 
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# 2-5 
* 1-15,2-43 
->MAIN 2-31 
-> PLOT 2-3, 2-46 
1 through 9 2-16 

A 
Adding 

an entry 2-59 
data points 2-55 
values to a series 2-55, 2-62 

Address 
drive 2-40 
slot 2-41 

Aesthetic charts 2-22 
Apple II requirements 1-10 
Apple Silentype 1-5 
Applesoft ROM 1-16, 1-17 
AREA 3-7 
Area chart 1-2, 1-7 
Area, status 1-18,3-2 
ARITH 2-63,3-7 
Arrow keys 1-14 
Asterisk (*) 1-15,2-43 
Axis 1-5 

B 
BACKGR 2-30, 3-7 
Background color 2-30, 3-7 
BAR 2-8, 3-8 
Bar 

chart 1-2, 1-7,2-8,3-8 
menu 2-8 

Basic use of the plot program 2-1 
BOLD 2-13, 3-9 

Bold typeface 2-13,3-9 
BOTH 2-29, 3-9 
BOTTOM 2-15,3-9 

c 
Calling the plot program 2-46, 

3-19 
Care of diskettes 1-12 

INDEX 

Changes, removing 2-62, 3-23 
Changing 

the drive number 2-40 
the range 2-23, 3-20 
the scale 2-20, 3-20 
the series specifications 2-60, 

3-22 
Charts 1-8 
Charts 

AREA 1-2,1-7,3-7 
BAR 1-1,1-7,2-8,2-71,3-8 
HI-LO 1-3, 1-7,3-13 
LINE I-I, 1-7,2-4,2-68,3-15 
PIE 1-2,1-7,2-76,3-18 
SCATTER 1-3, 1-7,2-81,3-21 

CLEAR 2-46, 3-9 
Clearing series from memory 

2-46, 3-9 
COLOR 2-31,3-9 
Color capability 1-6, 3-7, 3-9 
Command 1-8 
Commands, editor 2-57 

DELETE 2-59,3-11 
EDIT 2-58, 3-11 
EXIT 2-57, 3-11 
FILL 2-62, 3-12 
FORMAT 2-61,3-12 
INSERT 2-59, 3-14 
JUMP 2-59,3-14 
PRINT 2-61,3-19 
SPECS 2-60, 3-22 
UNDO 2-62, 3-23 

Comparative bar chart 2-73 
Confusing the VisiPlot program 

2-21 
CONTINUE 2-37, 3-10 
Control-C 1-15 
Controller card, disk 1-10 
Copyright notice 1-18 
Creating a data diskette 2-45 
Creating series data 2-53, 3-11 
CTRL key 1-20 
Current series 2-6 
Cursor 1-6,1-8, 1-19 
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D 
Data 

diskette address 2-34, 3-11 
diskettes 2-34 
drive number, changing 2-41, 

3-11 
entry 2-55 
formatting 2-61,3-12 
interchange format 1-6,2-49, 

3-11 
keeping between programs 

2-47 
loading 2-35, 3-15 
point 1-8 
points, deleting 2-59, 3-11 
points, inserting 2-59,3-14 
saving 2-42, 3-21 
series 1-10 

Date 1-8 
DEFAULT 3-10 
Definitions 1-8 
DELETE 2-48, 2-59, 3-11 
Deleting 

data points 2-59, 3-11 
files 2-48, 3-11 
series 2-46, 3-9 

DIF 2-42, 2-49, 3-11 
DIF format 1~6, 2-49, 3-11 
Disk 

controller card 1-10 
drives 2-40, 3-11 
errors 2-41 

Diskettes 
care 1-12 
data 2-34 
program 1-11, 2-34 

Display, startup 1-18 
Displaying 

large series 2-64 
two charts together 2-78 

Drawing 
charts 2-6 
grid lines 2-29 

DRIVE 2-40, 3-11 
Drive 1 2-40 
Drive 22-40 
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Drive 
address 2-40, 3-11 
and slot address 2-40,3-22 

E 
EDIT 2-53, 3-11 
Edit function, using 2-53, 3-11 
Editing 2-53,3-11 
Editor commands 2-57 

DELETE 2-59, 3-11 
EDIT 2-58,3-11 
EXIT 2-57,3-11 
FILL 2-62,3-12 
FORMAT 2-61,3-12 
INSERT 2-59, 3-14 
JUMP 2-59,3-14 
PRINT 2-61,3-19 
SPECS 2-60, 3-22 
UNDO 2-62, 3-23 

End 2-5 
Entry 2-55 
Entry configuration 2-13 
Erasing 

data points 2-59, 3-11 
moveable titles 2-17, 3-16 
series 2-27,3-9 
the legend 2-15,2-78,3-14 

Error messages 3-25 
Errors, disk 2-41 
ESC key 1-14 
Exercises 2-63 
EXIT 2-57,3-12 
Exiting 

F 

from VisiPlot 2-49,3-20 
the edit function 2-57, 3-11 

Features 1-5 
File 1-8 
Files 

and series 2-39 
deleting from data diskette 

2-48,3-11 
FILL 2-62, 3-12 
Fill menu 2-62,3-12 
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FORMAT 
chart 2-25,3-12 
data display 2-61,3-12 

Format, data 1-6, 3-12 
Format menu 2-26,3-12 
Frequency 1-9 
Function 1-9 
Functions, menu 

AREA 3-7,3-7 
ARITH 2-63,3-7 
BACKGR 2-30,3-7 
BAR 2-8,3-8 
BOLD 2-13,3-9 
BOTH 2-29, 3-9 
BOTTOM 2-15, 3-9 
CLEAR 2-46, 3-9 
COLOR 2-31, 3-9 
CONTINUE 2-37,3-10 
DEFAULT 3-10 
DELETE 2-48, 3-11 
DIF 2-42,3-11 
DRIVE 2-40,3-11 
EDIT 2-53, 3-11 
EXIT 2-57, 3-11 
FILL 2-62, 3-12 
FORMAT 

chart 2-25, 3-12 
data 2-61,3-12 

GEOMET 2-63,3-13 
GRID 2-29,3-13 
HI-LO 3-13 
HORIZ 2-29,2-79,3-13 
INIT 2-45 
INSERT 2-59,3-14 
INTERP 2-63 
JUMP 2-59,3-14 
LEFT 2-15, 3-14 
LEGEND 2-18, 3-14 
LINE 2-4,3-15 
LINES 2-26,3-15 
LOAD 2-35,3-15 
LOOKUP 2-38,3-15 
-> MAIN 2-31, 3-15 
MAIN 2-48 
MOVEABLE 2-15, 3-16 
NAME 2-61,3-17 

G 

NEW 2-25,3-17 
NONE 2-4,3-17 
NORMAL 2-42,3-17 
OPTIONS 2-11,3-17 
OVERLAY 2-74, 3-17 
PER 3-18 
PIE 2-76, 3-18 
PIXSAVE 2-31,3-19 
->PLOT 2-3,2-46,3-19 
PLOT 2-6,3-19 
PRINT 2-30,3-19 
QUIT 2-49, 3-20 
RANGE 2-24, 3-20 
RESCALE 2-20,3-20 
RIGHT 2-8, 3-20 
SAVE 2-42,3-21 
SCATTER 2-81,3-21 
SELECT 2-8,3-21 
SET 2-24, 3-22 
SLOT 2-41, 3-22 
SPECS 2-60, 3-22 
START 2-61, 3-22 
SWITCH 2-78, 3-22 
SYMBOLS 2-26, 3-23 
TITLE 2-12, 3-23 
TOP 2-13,3-23 
UNDO 2-62, 3-23 
UNLABEL 2-31, 3-23 
VERT 2-29, 3-23 
WINDOW 2-78, 3-24 

GEOMET 2-63, 3-13 
Getting out of VisiPlot 2-49, 3-20 
GRID 1-9, 2-29, 3-13 
Grid lines 2-29,3-13 

H 
Hardcopy output I-IS, 2-30, 3-19 
HI-LO 3-13 
Hi-lo chart 1-3, 1-7,3-13 
HORIZ 2-29,2-79,3-13 
Horizontal 

axis 1-10 
grid lines 2-29, 3-13 
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How the data diskette is selected 
2-34 

How the range is calculated 
2-23, 3-3, 3-20 

How the scale is calculated 
2-20, 3-4, 3-20 

How to change 

I 

the range 2-23, 3-3, 3-20 
the scale 2-20, 3-4, 3-20 

I key 2-16, 3-16 
INIT 2-45 
INSERT 2-59, 3-14 
Inserting 

and removing diskettes 1-13 
data points 2-55, 3-14 
series 2-62 

Installation and Handling 1-11 
INTERP 2-63 
Introduction 1-1 
IN USE light 1-13 
Invoking the editor 2-53, 3-11 

J 
J key 2-16,2-16 
JUMP 2-59,3-14 

K 
K key 2-16,2-16 
Keeping data when changing 

programs 2-47 
Keyboard 1-14, 3-1 
Keyboard usage 3-1 

L 
Labels 2-31, 3-23 
Language System 1-10 
Large series displays 2-64 
Leaving the edit function 2-57, 

3-11 
LEFT 2-15,3-14 
LEGEND 2-18,3-14 
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Line charts 1-1,1-7,2-4,2-68, 
3-15 

LINE 2-4, 3-15 
LINES 2-26,3-15 
Lines, grid 2-29, 3-13 
List 1-9 
Listing series in memory 2-38, 

3-15 
Listing a series 2-63, 3-19 
LOAD 2-35, 3-15 
Loading 

VisiCalc data 2-50 
VisiPlot data 2-34, 3-15 
the program 1-16, 2-2 

Long prompt 1-19, 3-2 
LOOKUP 2-38,3-15 

M 
M key 2-16,2-16 
MAIN 2-48 
Main plot menu 2-5 
Main storage management 

menu 2-48 
Memory, clearing series from 

2-46,3-9 
Memory, listing contents 2-39, 

3-15 
Menu 1-9 
Menus 

Bar 2-8 
Edit Commands 2-57 
Fill 2-62 
Grid 2-29 
Main Plot 2-5 
Main Storage Management 

2-33 
Options 2-11 
Select 2-4 
Specs 2-60 
Title 2-12 
Typeface 2-13 
Window 2-78 

Menu functions 
AREA 3-7,3-7 
ARITH 2-63,3-7 
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BACKGR 2-30,3-7 
BAR 2-8,3-8 
BOLD 2-13, 3-9 
BOTH 2-29, 3-9 
BOTTOM 2-15,3-9 
CLEAR 2-47, 3-9 
COLOR 2-31,3-9 
CONTINUE 2-37, 3-10 
DEFAULT 3-10 
DELETE 2-48,3-11 
DIF 2-42,3-11 
DRIVE 2-41, 3-11 
EDIT 2-53,3-11 
EXIT 2-57,3-11 
FILL 2-62,3-12 
FORMAT 

chart 2-25,3-12 
data 2-61,3-12 

GEOMET 2-63, 3-13 
GRID 2-29, 3-13 
HI-LO 3-13 
HORIZ 2-29, 2-79,3-13 
INIT 2-45 
INSERT 2-59,3-14 
INTERP 2-63 
JUMP 2-59, 3-14 
LEFT 2-15,3-14 
LEGEND 2-18, 3-14 
LINE 2-4, 3-15 
LINES 2-26,3-15 
LOAD 2-35, 3-15 
LOOKUP 2-38, 3-15 
-> MAIN 2-31,3-15 
MAIN 2-48 
MOVEABLE 2-15, 3-16 
NAME 2-61,3-17 
NEW 2-25, 3-17 
NONE 2-4,3-17 
NORMAL 2-42, 3-17 
OPTIONS 2-11,3-17 
OVERLAY 2-76,3-17 
PER 3-18 
PIE 2-76, 3-18 
PIXSAVE 2-31,3-19 
-> PLOT 2-3,2-47,3-19 
PLOT 2-6, 3-19 

PRINT 2-30,3-19 
QUIT 2-49, 3-20 
RANGE 2-24, 3-20 
RESCALE 2-20, 3-20 
RIGHT 2-8, 3-20 
SAVE 2-42, 3-21 
SCATTER 2-81, 3-21 
SELECT 2-8, 3-21 
SET 2-24, 3-22 
SLOT 2-41,3-22 
SPECS 2-60, 3-22 
START 2-61, 3-22 
SWITCH 2-78,3-22 
SYMBOLS 2-26, 3-23 
TITLE 2-12,3-23 
TOP 2-13, 3-23 
UNDO 2-62, 3-23 
UNLABEL 2-31,3-23 
VERT 2-29, 3-23 
WINDOW 2-78, 3-24 

Messages, error 3-25 
Modifying data series 2-56, 3-11 
Modulator, RF 1-11 
Monitor 1-10 
MOVEABLE 2-15, 3-16 
Moveable title speed 2-16,3-16 
Moveable titles 2-15,3-16 
Moving 

N 

a title 2-15,3-16 
from point to point, jump 2-59, 

3-14 

Name 2-4 
NAME 2-61,3-17 
NEC Spinwriter 1-5 
NEW 2-25,3-17 
NONE 2-4, 3-17 
NORMAL 

o 

storage format 2-42 
typeface 2-13, 3-17 

OPTIONS 2-11,3-17 
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Option menu 2-11 
Options, plotting 2-11, 3-17 
OVERLAY 2-74,3-17 

p 

Paper Tiger 1-5 
PER 2-4,3-18 
Period 1-9, 3-18 
Pie chart 1-2,1-7,2-76,3-18 
PIE chart data 2-75 
PIXSAVE 2-31, 3-19 
PLOT 2-6,3-19 
Plot program 2-2 
Point, data 1-9 
Pound sign (#) 2-5 
Power switch 1-17 
PRINT 2-30,3-19 
Printer support 1-15 
Printers 

Apple Silentype 1-5 
IDS Paper Tiger 1-5 
NEC Spinwriter 1-5 
Trendcom 1-5 

Printing 
charts 2-30, 3-19 
data from the screen 2-61,3-19 

Program diskette 1-11, 2-35 
Program loading 1-16, 2-2 
Progressions 

ARITH 2-63, 3-7 
GEOMET 2-63, 3-13 

Prompt, long 1-19,3-2 
Putting titles on a chart 2-12, 

3-23 

Q 
QUIT 2-49, 3-20 

R 
RAM memory 1-10 
Range 1-9, 2-19, 3-3, 3-20 
RANGE 2-24, 3-20 
Range, changing 2-23, 3-3, 3-20 
Recovering the legend 2-18,3-9 

APPLE II 

Reference 3-1 
Removing 

changes 2-62, 3-23 
data points 2-59, 3-11 
diskettes 1-13 
series 2-46, 3-9 

INDEX 

Replacing values in a series 2-56 
Requirements, computer 1-10 
RESCALE 2-20, 3-20 
RESET key 1-14, 1-20 
RETURN 1-14 
Returning 

to the Basic program 2-49, 
3-20 

to the edit function 2-58,3-11 
to the main menu 2-48,3-11 

Reverse video 1-18 
RF modulator 1-11 
RIGHT 2-8, 3-20 

s 
SAVE 2-42, 3-21 
Saving 2-42,3-21 
Scale 1-9,2-19,3-4,3-20 
Scale, changing 2-20, 3-4,3-20 
SCATTER 1-3, 1-7, 2-81, 3-21 
Scrolling the screen 2-64 
SELECT 2-8, 3-21 
Select menu 2-4 
Selecting a menu item 1-19 
Series 

adding values 2-55, 3-14 
and files 2-39 
clearing from memory 2-46, 

3-9 
data 1-10 
specifications, changing 2-61, 

3-22 
SET 2-24, 3-22 
Setting up the computer 1-10 
Shading and titling a pie chart 

2-77 
Shift 1-20 
SLOT 2-41, 3-22 
Slot 

address 2-41,3-22 

INDEX-6 



APPLE II 
INDEX 

and drive address 2-40, 3-11 
Space bar 1-14, 3-1 
SPECS 2-60,3-22 
Speed of moveable titles 2-16, 

3-16 
Start 2-4 
ST ART 2-63, 3-22 
Starting date 2-4 
Startup display 1-18 
Status area 1-18, 3-2 
Storage Management functions 

2-32 
Storage Management 2-32 
Summary 1-21 
SWITCH 2-78, 3-22 
Switch, power 1-17 
SYMBOLS 2-26, 3-23 
System Master Diskette 1-16, 

1-17 

T 
Three line display 2-70 
TITLE 2-12, 3-23 
Title 

menu 2-12 
moveable 2-15 

Titling 
a chart 2-12,3-23 
and shading pie chart 2-77 

TOP 2-13, 3-23 
Trendcom 1-5 
TV set 1-10 
Two line display 2-69 
Typeface 

BOLD 2-13, 3-9 

VISIPLOT™ 

NORMAL 2-13, 3-17 

u 
UNDO 2-62, 3-23 
UNLABEL 2-31, 3-23 
Using 

v 

the Edit function 2-53 
the program 1-6 

VER T 2-29, 3-23 
Vertical 

axis 1-10 
grid lines 2-29,3-13 

Video 
monitor 1-10 
reverse 1-18 

VisiCalc 2-49 

w 
WINDOW 2-78, 3-24 
Wraparound, cursor 1-19 

x 
X-axis 1-10 

y 

Y key 2-3 
Y-axis 1-10 

INDEX-7 

USER'S 
GUIDE 
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